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EPSON AMERICA, INC.
LIMITED WARRANTY

What is Covered:  Epson America, Inc. (“Epson”) warrants to the first end-user 
customer of the EPSON PhotoPC 600 Digital Camera enclosed with this limited 
warranty statement, if purchased and used in the United States or Canada, conforms 
to the manufacturer’s specifications and will be free from defects in workmanship and 
materials for a period of one year from the date of original purchase. Epson further 
warrants to the first end-user customer that the Nickel Metal Hydride Battery 
Charger and four Nickel Metal Hydride Batteries enclosed with this limited warranty 
statement will be free from defects in workmanship and materials for a period of 
ninety days from the date of original purchase.  EPSON warrants that the EPSON 
product is manufactured from new components and parts or like-new components 
and parts which perform like new and meet the EPSON standard of quality.

What Epson Will Do To Correct Problems:  Should your EPSON product prove 
defective during the warranty period, please call the EPSON Connection at 
800-922-8911 for warranty repair instructions and return authorization, if required.  
Epson will, at its option, repair or replace on an exchange basis the defective unit, 
without charge for parts or labor.  If the product requires repair or replacement, 
package it in its original container or an equivalent, along with proof of the date of 
original purchase.  When warranty service involves the exchange of the product or of 
a part, the item replaced becomes EPSON property.  The exchanged product or part 
may be new or previously repaired to the EPSON standard of quality.  Exchange or 
replacement products or parts assume the remaining warranty period of the product 
covered by this limited warranty.

What This Warranty Does Not Cover:  This warranty covers only normal consumer 
use in the United States and Canada.  This warranty does not cover damage to the 
EPSON product caused by parts or supplies not manufactured, distributed or 
certified by EPSON.  This warranty does not cover third party parts, components or 
peripheral devices added to the EPSON product after its shipment from EPSON.  
EPSON is not responsible for warranty service should the EPSON label or logo or the 
rating label or serial number be removed or should the product fail to be properly 
maintained or fail to function properly as a result of misuse, abuse, improper 
installation, neglect, improper shipping, damage caused by disasters such as fire, 
flood, and lightning, improper electrical current, software problems, interaction with 

non-EPSON products, or service other than by an EPSON Authorized Servicer.  
Packaging and shipping costs incurred in presenting your EPSON product for 
warranty service are your responsibility.  Shipping costs from the EPSON repair 
facility will be EPSON’s responsibility.  If a claimed defect cannot be identified or 
reproduced in service, you will be held responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE 
AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES 
ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE.  
UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS 
MADE BY ANY OTHER PERSON OR FIRM ARE VOID.  EXCEPT AS 
PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, 
INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, 
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE 
USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER 
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL 
THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts 
and some jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitations and exclusions may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights which 
vary from jurisdiction to jurisdiction.

To locate the EPSON Authorized Reseller nearest you call:

(800) 922-8911
or write to:

Epson America, Inc.  •  P. O. Box 2842  •  Torrance, CA  90509-2842  •  MS:CS1
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IMPORTANT NOTICE
DISCLAIMER OF WARRANTY

Epson America makes no representations or warranties, either express or 
implied, by or with respect to anything in this manual, and shall not be liable for 
any implied warranties of merchantability and fitness for a particular purpose or 
for any indirect, special, or consequential damages. Some states do not allow the 
exclusion of incidental or consequential damages, so this exclusion may not 
apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without the prior written 
permission of Epson America, Inc. No patent liability is assumed with respect to 
the use of information contained herein. Nor is any liability assumed for 
damages resulting from the use of the information contained herein. Further, 
this publication and features described herein are subject to change without 
notice.

TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON 
CORPORATION.

PhotoPC, EPSON SoundAdvice, and EPSON FaxAdvice are trademarks of 
Epson America, Inc. 

Image Expert and Camio are trademarks of Sierra Imaging, Inc. in the United 
States and other countries and are used under license.

General notice: Other product names used herein are for identification purposes 
only and may be trademarks of their respective owners. EPSON disclaims any 
and all rights in those marks.

Copyright © 1997 by Epson America, Inc. CPD5281                                     
Torrance, California, USA 4007823

8/97

A NOTE CONCERNING RESPONSIBLE USE OF 
COPYRIGHTED MATERIALS

Digital cameras and scanners, like photocopiers and conventional cameras, can 
be misused by improper copying of copyrighted material. While some countries’ 
laws permit limited copying in certain circumstances, those circumstances may 
not be as broad as some people assume. EPSON encourages each user to be 
responsible and respectful of the copyright laws when using digital cameras and 
scanners.
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CONTINENTAL REALTY
3521 Ojai Way

Sun Park, WE 9999
(999) 888-888

ω 4 Bedroom/3 Bathroom

ω Dinning Room

ω Pool

ω 2 Car Garage

ω Original Owner

ω Excellent location

− Near schools and park

ω Competitive price

NEW LISTING...

Contact Monica for an
Appointment

999-888-8888

our new EPSON PhotoPC™ 600 is an advanced,Y easy-to-use digital camera with a built-in LCD screen. 

You can view your pictures before and after you capture 

them, or display them on a TV or multimedia projector and 

transfer them to your computer.  You can even upload 

pictures, text, and graphics into your camera, and play them 

back for presentations. 

PhotoPC 600 captures images in 24-bit color at XGA 

resolution (1024 × 768 pixels). Macro, zoom, panorama, and 

multi-frame modes give you the flexibility you need for 

professional results. You can expand the camera’s capacity 

with optional CompactFlash™ memory cards. Your 

PhotoPC 600 comes complete with cables, batteries, battery 

charger, software, and utilities for downloading, editing, 

organizing, and printing your pictures. 

Introduction
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PhotoPC 600 Features

PhotoPC 600 is a complete system for capturing digital 

images, and includes the following features:

◗ Resolutions up to 1024 × 768 pixels

◗ 4MB internal flash memory that holds at least 16 high-

resolution or 50 standard-resolution images

◗ 24-bit color or 8-bit grayscale image capture

◗ Two-inch, active matrix TFT color LCD screen for 

previewing and playing back pictures

◗ Video output for playing your pictures back on a TV, 

VCR, or projector

◗ Macro, digital zoom, panorama, and multi-frame picture 

formats

◗ Built-in flash 

◗ Automatic shut-off to save batteries

◗ Automatic date and time recording for each picture

◗ Cables for transferring photos to your Windows PC or 

Macintosh and displaying on a TV or multimedia 

projector

Your camera comes with the PhotoPC 600 software suite, 

which includes the following applications:

◗ Sierra Image Expert™ software for transferring, 

organizing, editing, and printing your pictures

◗ The EPSON Photo!2 application and TWAIN driver 

for transferring and converting your pictures

◗ EPSON Photo File Uploader for converting 

presentation slides into image files and uploading them 

into your camera

◗ EPSON Photo!2 Program Uploader for adding new 

firmware that will let you print directly from the camera
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Optional Accessories

EPSON offers these accessories for the PhotoPC 600:

◗ AC adapter for use with any electrical outlet

◗ EPSON Stylus Photo Direct Print kit that allows you to 

print directly from the camera to the EPSON Stylus 

Photo printer (Check EPSON’s website for availability.)

◗ Replacement NiMH rechargeable batteries

◗ Replacement NiMH Power Pak including batteries and 

charger

You can also use CompactFlash memory cards and PCMCIA 

adapters available from leading suppliers, such as Simple 

Technology or SanDisk. 

Minimum System Requirements

To transfer images to your computer and edit them, make 

sure your system meets these minimum requirements:

Windows Systems

◗ IBM-compatible PC with 486 or higher processor

◗ Microsoft Windows 95, Windows 3.1 or later, 

Windows for Workgroups 3.11 or later, or 

Windows NT 3.5 or later

◗ Serial port with standard RS-232C interface

◗ At least 16MB RAM 

◗ Double-speed CD-ROM drive

◗ Hard disk drive with at least 30MB free space

◗ VGA or SVGA monitor with at least 256-color display

◗ Mouse or other pointing device
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Macintosh Systems

◗ Macintosh 68040 or higher or PowerPC™ processor

◗ System Software Version 7.1 or later (System 7.5 or later 

is required to access optional CompactFlash card 

memory directly from the Macintosh.)

◗ 16MB RAM

◗ At least 30MB free hard disk space

◗ Double-speed CD-ROM drive

◗ VGA monitor with at least 256 colors

◗ Standard Macintosh modem/printer serial port

Where To Get Help

EPSON provides customer support through the following 
services:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home 
Page at http://www.epson.com.

EPSON Internet FTP Site If you have Internet FTP capability, use your Web 
browser (or other software for FTP downloading) 
to log onto ftp.epson.com with the user name 
anonymous and your e-mail address as the 
password.

EPSON Download Service You can call the EPSON Download Service at 
(800) 442-2007. Set your communications 
software to 8 data bits, 1 stop bit, no parity. 
Modem speed can be up to 28.8 Kbps.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at 
the menu prompt to reach the Epson America 
Forum. For a free introductory CompuServe 
membership, call (800) 848-8199 and ask for 
representative #529.

Automated telephone services

Service Access

EPSON SoundAdvice™ Pre-recorded answers to commonly asked 
questions about EPSON products 24 hours a day, 
seven days a week, call (800) 442-2110.

EPSON FaxAdvice™ Access EPSON’s technical information library by 
calling (800) 442-2110. You must provide a return 
fax number to use this service.

EPSON Referral Service For the location of your nearest Authorized 
EPSON Reseller call (800) 442-2110.

Electronic support services (continued)

Service Access
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EPSON also provides technical support and information on 

the installation, configuration, and operation of EPSON 

products. Dial (800) 922-8911, (310) 782-2600 (U.S.), or 

(905) 709-9475 (Canada), 6 A.M. to 6 P.M., Pacific Time, 

Monday through Friday.

Before you call, please have the following information ready:

◗ Product name

◗ Product serial number

◗ Computer configuration

◗ Description of the problem

You can purchase manuals, accessories, and parts from 

EPSON Accessories at (800) 873-7766 (U.S. sales only). In 

Canada, please call (800) 873-7766 for dealer referral.

Software Support

If you’ve tried the on-screen help and you still have 

questions, call one of the following numbers for technical 

support:

◗ (800) 501-8902 for Image Expert (For Windows 95 

users, make sure you check the Quick Tour first)

◗ (800) 922-8911 for EPSON Photo!2

Registration

Please take a minute to fill out the registration card for the 

PhotoPC 600 digital camera and mail it back to us. This 

enables you to receive special information on accessories, 

new products, and software upgrades. You’ll get immediate 

attention if you have a problem with your PhotoPC 600.
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Safety Instructions

Read all of these instructions before using your camera and 

battery charger. Also follow all warnings and instructions 

marked on the camera, battery charger, and batteries.

◗ To reduce the risk of electric shock, do not remove the 

camera’s cover or open any of the compartments except 

as instructed in this User’s Guide.

◗ To prevent fire or electric shock, do not insert objects 

through any openings in the camera or battery charger. 

Do not expose the camera or battery charger to rain or 

moisture.

◗ To prevent fire or explosion, do not use the camera or 

battery charger where inflammable or volatile gas is 

stored.

◗ If the camera shows unusual signs such as noise, odor, or 

smoke, turn it off immediately. Remove the batteries 

and/or disconnect the AC adapter, and unplug the AC 

adapter from the electrical outlet.

◗ If the battery charger shows unusual signs such as noise, 

odor, or smoke, unplug it immediately.

◗ To avoid damage to the optics of the camera, do not 

expose the lens to direct sunlight for extended periods of 

time.

◗ Do not use the charger near water. Never insert or 

remove the charger’s power plug with wet hands.

◗ Keep the charger away from heat sources. Do not use 

outside the temperature range of 35 to 95°F (0 to 35°C)

◗ Do not use the charger within reach of children.

◗ Use only the types of power sources listed on the charger 

label and in this User’s Guide. Always supply power to 

the charger directly from a standard domestic electrical 

outlet.

◗ Do not use the camera outdoors during adverse weather 

conditions.
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◗ Do not store the camera near sources of bright light, 

direct sunlight, high humidity, heat, excessive dirt or 

dust, or where it will be exposed to strong vibrations or 

magnetic fields.

◗ To prevent possible eye injury, do not take flash pictures 

of faces at close range.

◗ Avoid sudden temperature changes, which can cause 

moisture to condense on the camera. Keep the camera in 

a case or bag if you need to move it from a cold 

environment to a warm one. Allow time for the camera 

and its optional accessories to adjust to temperature 

changes before using them.

◗ Do not use a frayed or damaged power cord with the 

AC adapter.

◗ If you use an extension cord with the optional AC 

adapter, make sure the total ampere rating of the devices 

plugged into the extension cord does not exceed the 

cord’s ampere rating. Also, make sure the total ampere 

rating of all devices plugged into the wall outlet does not 

exceed the wall outlet’s ampere rating.

◗ Remove batteries and/or unplug the camera and the AC 

adapter and refer servicing to qualified service personnel 

under the following conditions: if the power cord or 

plug is damaged; if liquid has entered the camera; if the 

camera has been dropped or its exterior has been 

damaged; if the camera or its optional accessories do not 

operate normally or exhibit a distinct change in 

performance.

◗ Adjust only those controls that are covered by the 

operating instructions.

◗ Do not attempt to service the camera or battery charger 

yourself. Refer all servicing to qualified service 

personnel.

◗ If the liquid crystal solution contained in the display 

panel or in the LCD screen leaks out and gets on your 

hands, wash them thoroughly with soap and water. If it 

gets in your eyes, flush them immediately with water.

Popint.fm5  Page 7  Tuesday, August 26, 1997  5:25 PM



Getting Started   1-1

A

B

1
.

1   

PhotoPC 600 cable

software

Mac 
adapter 
cable

batteries

hand strap

camera

video cable

battery charger

his chapter helps you get ready to use your new TPhotoPC 600. It covers the following:

◗ Unpacking your PhotoPC 600

◗ Identifying camera parts

◗ Using batteries

◗ Attaching the hand strap

◗ Installing your PhotoPC 600 software

◗ Setting the language 

◗ Setting the date and time

Unpacking Your PhotoPC 600

Make sure you have all the parts shown to the left. If you’re 

using a PC, you won’t need the Macintosh adapter cable.

Getting Started
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Identifying Camera Parts

flash

viewfinder

timer light

front view

shutter button

lens
lens cover 
(on/off)

connector 
cover

bottom view

tripod socket
battery 
cover lock

battery cover

memory 
card eject 
lever
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hand strap 
holder

screen switch

display panel

viewfinder

picture 
format 
button

back view

memory 
card slotLCD screen

status 
light

top view

shutter 
buttonimage quality button

display 
panel

flash 
button

timer 
button macro 

button
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Using Rechargeable NiMH Batteries

To help lower the cost of ownership, your PhotoPC 600 

comes with four rechargeable NiMH batteries and a charger. 

Before you install the batteries in your camera, you may need 

to charge them two or three times so they are fully charged. 

The instructions in the following sections tell you how to 

charge, install, and handle batteries.

Charging Batteries

WARNING

Shock hazard. Make sure you use the charger only with EPSON 

rechargeable NiMH batteries (model EU-24). To avoid the danger 

of leakage or explosion, do not place any other batteries in the 

charger. Read all safety and handling instructions before using 

the charger. 

Note the following when charging batteries:

◗ Do not insert batteries backwards.

◗ Do not open the cover while batteries are charging.

◗ Do not use near water or handle with wet hands. For 

indoor use only.

◗ Do not use within reach of children.
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Follow these steps to charge your batteries:

1 Lift up the cover of the charger and insert all four 

batteries, positioning the + and – ends as shown. Then 

close the cover firmly.

2 Turn the charger over and flip the two prongs out of 

their compartment. 

3 Plug the charger into an electrical outlet.

Both lights turn red, indicating that the charger is 

working. When the batteries are fully charged, after 

about two and a half hours, the lights go off. To charge 

your batteries again, open and then close the charger 

again.

 

+
+

+

+

Popch1.fm5  Page 5  Tuesday, August 26, 1997  4:46 PM



1-6   Getting Started

NOTE

The charger lights flash to indicate changes in battery 

temperature and voltage. If the charger lights continue to 

flash for more than half an hour, the batteries may be 

damaged or worn out, and should be replaced. Unplug the 

charger if the batteries are not fully charged after two and a 

half hours.

4 When both lights are off, unplug the charger. To avoid 

overcharging, don’t leave the charger plugged in for long 

periods of time after the lights go off.

5 Wait one hour until the batteries cool before removing 

them from the charger.

6 Before storing the charger, press down on the prongs to 

lock the plug into place.

NOTE

Keep the charger terminals clean by wiping them with a dry cloth. 

Make sure you charge all four batteries before you use them. If 

you find that your batteries run out faster after you recharge them 

a few times, make sure you discharge them completely before 

recharging. If this doesn’t help, replace the batteries.

Installing Batteries

Before you install the batteries, make sure the camera is 

turned off (the lens cover is closed). Then follow these steps:

1 Turn the camera upside down with the LCD screen 

facing you. 
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2 Push the battery cover lock down. While holding the 

lock, slide the battery cover to the left to open it.

 

3 Insert all four batteries into the compartment, 

positioning the + and - ends as shown below:

4 Close the battery cover and slide it to the right until it 

snaps into place.

+

+
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Handling Batteries

If you need to replace your rechargeable NiMH batteries, the 

camera can also accept the following:

◗ Rechargeable AA NiCad batteries

◗ Single-use AA alkaline batteries (Energizer brand 

recommended)

◗ Single-use AA lithium batteries (longer life)

WARNING

To avoid the danger of fire or explosion, do not mix different 

types of batteries. Do not allow the battery contacts to touch 

metal objects such as coins or keys, which could short out the 

battery’s circuits. Read all safety and handling instructions before 

using batteries.

Note the following when handling batteries:

◗ Use only the EPSON battery charger (Model EU-23) to 

charge the batteries that came with your camera.

Pour usage avec le chargeur de piles modele EU-23.

◗ Use the batteries that came with your camera only in 

EPSON digital cameras.

◗ Do not use manganese batteries.

◗ Replace all four batteries at the same time.

◗ Batteries that have not been used for a long time do not 

charge well. However, with regular use, the batteries will 

return to normal.

◗ Batteries discharge 2% per day, whether they are used or 

not.

◗ If the batteries are not fully discharged before you charge 

them, your camera’s operating time may decrease 

temporarily.

◗ If the batteries are charged in a hot environment, or if 

they are charged repeatedly without being discharged, 

they will wear out more quickly.

◗ Do not drop, puncture, disassemble, or mutilate 

batteries. Do not get them wet or expose them to fire.
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◗ When the camera is not used for long periods of time, 

remove the batteries and store them at a low temperature 

in a dry location. Store away from the reach of children.

◗ To avoid fire or electric shock, do not use batteries that 

are leaking or damaged in any way.

◗ If battery acid gets in your eyes or on your skin, 

immediately rinse the area with water and seek medical 

treatment. If a battery is swallowed, seek medical 

treatment immediately.

◗ Dispose of used batteries according to the 

manufacturer’s instructions and in compliance with all 

applicable laws. Contact your local government agency 

for information about battery recycling and disposal.

◗ Battery life varies depending on the battery type and the 

manufacturer.

Attaching the Hand Strap

To attach the hand strap, loop the strap around the holder 

on the side of the camera as shown below.

.
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Installing Your PhotoPC 600 Software

PhotoPC 600 comes with everything you need to transfer 

your pictures from the camera to your computer, organize, 

enhance, and share your images, and insert them into 

documents. You can also upload pictures and presentations 

into your camera. The included CD-ROM has these 

applications for your Windows PC or Macintosh: 

◗ Sierra Image Expert 

◗ EPSON Photo!2 TWAIN and standalone application

◗ EPSON Photo File Uploader

◗ EPSON Photo!2 Program Uploader

All programs will be installed in the PhotoPC 600 folder.

Installing for Windows 95 or 

Windows NT 4.0

Follow these steps:

1 Insert the CD-ROM in your drive. The install program 

starts automatically.

If it doesn’t start automatically, double-click 

My Computer. Then double-click your CD-ROM 

icon. 

2 Follow the instructions on the screen.

NOTE

After you install your software for Windows 95, you can run the 

Image Expert Quick Tour to learn more about your camera. See 

page 4-5 for instructions.
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Installing for Windows 3.1x or 

Windows NT 3.51

Follow these steps:

1 Insert the CD-ROM in your drive.

2 In the Program Manager, select Run from the File 

menu.

3 Type D:\SETUP. If your CD-ROM drive is not 

drive D, substitute the correct letter. 

4 Click OK and follow the instructions on the screen.

Installing on a Macintosh

Follow these steps:

1 Insert the CD-ROM in your drive. 

2 Double-click the CD-ROM icon. 

3 Double-click the Install Image Expert icon. Click 

Continue and follow the instructions on the screen.

Making Software Installation Diskettes

You can create Image Expert installation diskettes from the 

CD-ROM, following the instructions below. If you need the 

EPSON Photo!2 software and utilities on diskette, you can 

download the files from the EPSON website at 

www.epson.com.

Making Windows Diskettes

Before you start, make sure you have 6 blank, formatted 

diskettes for Windows 3.1 or 9 for Windows 95 and 

Windows NT. Then follow these steps:

1 Use the Windows Explorer (or File Manager) to access 

your CD-ROM drive. (You may have to exit the Setup 

program first.) 

2 Double-click Mkfloppy.

3 Depending on which version of Windows you’re using, 

select Windows 95/Windows NT or Windows 3.1. 

Then select your diskette drive and click OK. Follow the 

instructions on the screen to create the installation 

diskettes.
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Making Macintosh Diskettes

Before you start, make sure you have 8 blank, formatted 

diskettes. You can use either the Disk Copy 6.2 utility (you 

can download it from the Apple website if you don’t have 

it), or the DropImage program on the PhotoPC 600 

CD-ROM. 

To use Disk Copy 6.2, double-click the file named 

Make Floppies and follow the instructions on the screen. 

The Image Expert disk image files are located in the Disk 

Images folder on the CD-ROM.

Follow these steps to make diskettes using the DropImage 

program:

1 Open the Disk Images folder on your CD-ROM.

2 Drag the file Disk1.image onto DropImage 1.0. An 

icon for Disk 1 appears on your desktop.

3 Insert a blank, formatted diskette in your drive and 

change its name to Image Expert 1.

4 Drag the Disk 1 icon onto the Image Expert 1 icon. If 

you are asked to confirm the copy, click Yes.

5 When the copy finishes, drag both icons to the trash. 

Your Macintosh ejects the diskette.

6 Repeat steps 2 to 5 for each disk image file.

Setting the Language

Before you use the camera, you need to set the language for 

information displayed on the LCD screen.

Follow these steps to select English:

1 Slide the screen switch to Playback. 

screen switch

SELECT 
button

BACK 
button
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You see a message asking you to select your language.

2 Press the SELECT button. You see the Language Setting 

menu:

3 Press the SELECT button until English is highlighted. 

4 Press the BACK button to save your selection.

5 Slide the screen switch OFF.

Setting the Date and Time

Before you use the camera, you need to set its clock. Then 

the camera will automatically record the date and time for 

each picture you take. You’ll need to set the clock again 

whenever you install new or recharged batteries.

NOTE

You can also set the camera’s clock through your computer. See 

Chapter 4 for instructions on connecting the camera to your 

computer, and page 8-6 for instructions on setting the date and 

time.

Follow these steps to set the camera’s clock:

1 Slide the screen switch to Playback. You see a message 

asking you to set the clock.

2 Press the SELECT button. 

You see the clock setting screen, with the year setting 

highlighted in red:

3 If necessary, press the  button to increase the 

number or the  button to decrease the number, 

until the year is correct.
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4 Press the SELECT button. The year setting is saved and 

the month setting is highlighted.

5 Adjust the month, day, hour, and minute settings as 

described above until the date and time are correctly 

adjusted and saved.

After you finish setting the clock and press the SELECT 

button, your screen returns to playback mode. 

6 Slide the screen switch OFF.
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Jim Jackson’s Auto Sales

• 1995 Mitsubishi Montero

• Good condition

• Low Mileage

FOR SALEFOR SALE

999-555-5555

aking pictures with PhotoPC 600 is similar toTusing a traditional “point and shoot” camera. This 

chapter tells you everything you need to know, including the 

following information:

◗ Getting ready to take pictures

◗ Taking pictures with the viewfinder

◗ Taking pictures with the LCD screen

◗ Using macro mode to take close-ups

◗ Using the flash

◗ Taking pictures with the timer

◗ Setting image quality and color mode

◗ Taking special format pictures

◗ Checking the picture counter

Taking Pictures 
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Getting Ready to Take Pictures

Before you can take pictures with PhotoPC 600, you need to 

turn on the camera and check the display panel. It’s 

important to be aware of the camera’s power-saving features 

and the status of your batteries. 

Turning the Camera On and Off

To turn the camera on, rotate the lens cover 

counterclockwise. The lens cover opens and the display panel 

on the top of the camera lights up, as shown in the 

illustration on the right. The status light on the back of the 

camera flashes for a few seconds. When it turns green, the 

camera is ready to take pictures.

To turn off the camera, rotate the lens cover clockwise. The 

lens cover closes and the display panel turns off.

.

Saving Power With Auto Shut-off

If you wait more than 60 seconds before taking a picture, the 

camera turns off automatically to save battery power. To 

turn the camera back on, close the lens cover and then open 

it again. 

If you want, you can change the 60-second time period for 

auto shut-off. For more information, see pages 8-6 and 8-8.

display panel

On

Off
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Using the Display Panel

The display panel shows the status of your batteries, the 

camera’s current settings, and the number of pictures 

remaining.

.

Checking the Battery

When your battery power is almost out, the low 

battery icon appears on the display panel. The icon 

flashes when your battery power is completely out. At this 

point, you can’t take pictures until you recharge or replace 

the batteries or use the AC adapter.

Several factors can affect battery life, including the 

surrounding temperature and the type of batteries you use. 

Low temperatures—especially below 50 °F (10 °C)—drain 

your batteries faster. See page 1-4 for battery use 

instructions.

Taking Pictures With the Viewfinder

You can capture an image with PhotoPC 600 as you would 

with any point-and-shoot camera: look through the 

viewfinder and snap the shutter. However, you can also use 

the LCD screen to preview your picture. See page 2-5 for 

instructions on using the LCD screen. 

Follow these steps to take a picture with the optical 

viewfinder:

1 Make sure you are at least 20 inches (50 cm) away from 

your subject.

timer

pictures 
remaining

image 
quality

low battery 
icon

flash 
mode 

macro 
mode 
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2 Turn the camera on and wait until the status light turns 

green.

3 Look straight through the viewfinder and center your 

subject within the cross-hairs.

4 Hold the shutter button halfway down to lock the auto 

focus. The status light changes from green to orange. At 

this point, you can move your subject off-center if you 

want.

5 Press the shutter button the rest of the way down to take 

the picture.

6 Hold the camera still until it beeps and the status light 

starts flashing red.

The flashing red light indicates that the camera has captured 

the image and is processing it. 

CAUTION

If you set the camera down while it is processing a picture, make 

sure you handle it carefully. The camera may lose your image if 

you set it down too hard.

When the light stops flashing and turns green, the image is 

saved and you can take another picture. Saved images remain 

in memory for at least a year, even when the camera is turned 

off and the batteries are removed.

NOTE

Remember that the camera shuts off automatically after 

60 seconds. To turn the camera back on, close the lens cover 

and then open it.

shutter 
button

status light

viewfinder
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Taking Pictures With the LCD Screen

The LCD screen lets you see a live preview of what the 

camera’s lens sees at any moment. You can take accurate 

close-ups and special format pictures using the screen.

NOTE

The image area displayed in the screen is slightly smaller than the 

view that will be captured. The preview on the screen may also 

appear to flicker under strong fluorescent lighting.

Follow these steps to take a picture with the LCD screen:

1 Turn the camera on and slide the screen switch to the 

View position. You see a preview of your picture on the 

LCD screen, with icons indicating the image quality 

setting , the number of pictures you can take , and 

the number of pictures taken .

2 Center your subject on the screen and then follow 

steps 4 and 5 on page 2-4. 

The LCD screen displays the picture you took with an 

icon  on the screen until the camera is finished 

processing. The screen may then be blank for a few 

moments before it returns to live preview.

3 Slide the switch OFF when you’re finished using the 

screen.

NOTE

The LCD screen uses up battery power quickly. If it is idle for 

more than 30 seconds, the screen turns off automatically. To turn 

it back on, slide the switch to OFF and then back to View.

screen switch
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Using Macro Mode to Take Close-ups

With the LCD screen, you can use the camera’s macro 

mode to take pictures as close as 8 inches (20 cm). 

Follow these steps:

1 Turn the camera on and slide the screen switch to the 

View position. You see a live preview on the LCD 

screen.

2 Press the macro button on top of the camera. 

The macro icon (shown above) appears on the display 

panel. For a few seconds, the word MACRO appears on 

the LCD screen, and the frame around the image turns 

green.

3 Press the shutter button to capture the image.

4 To turn off macro mode, press the macro button again 

or turn off the camera or LCD screen.

Using the Flash

The camera’s built-in flash is effective within a range of 

8 inches to 8 feet (20 cm to 2.4 m). Press the flash button to 

cycle through the three flash settings. An icon for each 

setting appears on the display panel as shown below:

Auto

The flash goes off automatically whenever it’s needed 

for adequate lighting (factory setting).

Flash Off

The flash is disabled, even when adequate lighting is 

not available. Use this setting for special effects, or 

where flash photography is prohibited.

macro flash timer 

image quality

 

AUTO
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Forced Flash

The flash goes off with every picture you take. Use this 

setting to compensate for backlighting; for example, 

when you are facing a light source.

After you take a flash picture, the icon blinks until the flash is 

fully recharged. Your flash setting remains in effect even after 

you turn off the camera.

TIP

When you’re taking pictures outdoors, make sure the sun is at 

your back. In very bright light (at the beach or in snow, for 

example), your pictures may come out too light. You can use 

Image Expert or other image editing software to correct most 

over-exposure problems.

Taking Pictures With the Timer

Setting the timer creates a 10-second delay between 

the time you press the shutter button and the actual 

image capture. This allows you to take a picture of yourself. 

Follow these steps to take a picture with the timer:

1 Secure the camera on a flat surface or on a tripod. (See 

page A-3 for information on attaching the camera to a 

tripod.)

2 Turn on the camera and wait until the status light turns 

green.

3 Press the timer button. The timer icon appears on the 

display panel.

4 Press the shutter button. The timer icon and the red 

timer light on the front of the camera flash slowly for 

8 seconds. Then they flash rapidly for 2 seconds before 

the shutter is released.

The camera beeps when the image is captured. The 

status light on the back of the camera flashes red as 

PhotoPC 600 processes the image. When the status light 

stops flashing and turns green, you can take another 

picture. 

5 To turn off the timer, press the timer button again or 

turn off the camera.
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Setting Image Quality and Color 

Mode

PhotoPC 600 has several image quality (resolution) settings: 

three for color pictures and two for black and white pictures. 

Press the image quality button on top of the camera to cycle 

from one setting to the other. The image quality icons appear 

on the display panel as shown below.

Fine

Produces color images at 1024 × 768 pixels, with 

moderate compression. Your pictures include ample detail, 

and the camera holds at least 16 pictures (factory setting).

Super Fine

Produces color images at 1024 × 768 pixels with low 

compression. Your pictures include greater detail, and the 

camera holds at least 7 pictures. With less compression, 

Super Fine images are better for pictures that will be enlarged.

Monochrome Fine

Produces black and white images at 1024 × 768 pixels, 

with moderate compression. Your pictures include 

ample detail, and the camera holds at least 16 pictures.

Monochrome Super Fine

Produces black and white images at 1024 × 768 

pixels with low compression. Your pictures include 

greater detail, and the camera holds at least 7 pictures. With 

less compression, Monochrome Super Fine images (like 

those in color) are better for pictures that will be enlarged.

Standard

Produces color images at 640 × 480 pixels. The camera 

holds at least 50 pictures, but the image size is smaller 

and includes less detail when enlarged.

Fine image quality is sufficient for most purposes. Use super 

fine if you need maximum detail (in enlargements, for 

example). Note that super fine image files are more than 

twice the size of fine quality image files. 

Popch2.fm5  Page 8  Tuesday, August 26, 1997  4:50 PM



Taking Pictures  2-9

A

B

2NOTE

You can switch freely between the settings and mix pictures of 

varying quality in the camera. The camera’s image capacity will 

vary accordingly. Depending on the content of your pictures, your 

camera may hold more than the numbers shown on page 2-8. As 

long as the display panel shows a number other than zero, you 

can continue taking pictures.

The following examples show the same image captured at 

standard, fine, and super fine quality.

Super fine quality image
1024 × 768 pixels, less compression

Fine quality image
1024 × 768 pixels

Standard quality image
640 × 480 pixels
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Taking Special Format Pictures

You can take three types of special format pictures with 

PhotoPC 600: digital zoom, panorama, and multi-frame. To 

shoot these types of pictures, you use the LCD screen and 

the buttons around the screen, as shown:

Before you start, turn the camera on and slide the screen 

switch to the View position. You see a preview of your 

picture on the LCD screen.

TIP

You can use macro mode in combination with any of these 

special formats.

Digital Zoom

Digital zoom pictures are captured at standard image 

quality (640 × 480 pixels). As you increase the 

magnification, your picture’s resolution will decrease (unlike 

a true optical zoom).

Follow these steps to take a zoom format picture:

1 Press the picture format button. 

A yellow frame appears around the previewed image, 

and you see the zoom icon, as shown above. (The image 

is not actually zoomed until you perform step 2.) 

2 Press the  button to zoom in on the image. 
picture format button arrow buttons

screen switch
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You can increase the zoom magnification rate as follows:

The zoom magnification rate appears in the upper right 

corner of the screen after you press the  button.

Press the  button to decrease the zoom rate. 

3 Press the shutter button halfway to lock the auto focus. 

Then press it the rest of the way down to capture the 

image. 

4 To return to normal picture format, press the picture 

format button again or turn off the camera or LCD.

Panorama

Images in the panorama format are long and narrow, 

although they are not captured at a wider angle than 

normal images. Follow these steps to take a panoramic 

picture:

1 Press the picture format button and then press the  

button once. 

Black margins appear at the top and bottom of the LCD 

screen, and you see the panorama icon, as shown above. 

You can use the image quality button on top of the 

camera to select fine or super fine image quality (both at 

1024 × 384 pixels) in color.

2 Press the shutter button halfway to lock the auto focus. 

Then press it the rest of the way down to capture the 

image. 

3 To return to normal picture format, press the picture 

format button again, or turn off the camera or LCD.

Press … To increase the zoom rate to …

Once 1.3 × 

Twice 1.6 × 

Three times 2 × 

Four times 2.5 × 

Five times 3 × 
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Multi-frame

When you use this format, the shutter releases 

9 times in rapid sequence, producing a single image 

composed of 9 stop-action mini pictures or frames. You can 

capture a complex motion, such as your golf swing, in a series 

of easy-to-see steps. Since each frame is low in resolution, 

multi-frame images are primarily for computer display. 

The camera captures 9 frames in a period of half a second. 

You can use the LCD screen Settings menu to change this 

period to one, two, or three seconds. See page 8-11 for 

instructions.

Follow these steps to take a multi-frame picture:

1 Press the photo format button and then press the 

button twice. 

A red frame appears around the previewed image, and 

you see the multi-frame icon at the bottom of the screen, 

as shown on page 2-12.

2 Press the shutter button. The LCD displays the 9 stop-

action images. The total image area is 640 × 480 pixels.

3 To return to normal picture format, press the picture 

format button again, or turn off the camera or LCD.

Checking the Picture Counter

The large number in the center of the display panel shows 

how many additional pictures you can take. This number 

depends on your image quality and special format settings. 

If you change these settings, the number will change.

When the camera’s memory is full, the number of pictures 

remaining is 0. The status light on the back of the camera 

turns red, and you can’t press the shutter button. 

To free up some of the camera’s memory, you can play back 

your pictures on the LCD screen and erase the ones you 

don’t want to save. See page 3-6 for instructions. If you want 

to save your pictures before you erase them, you need to 

connect the camera to your computer and transfer the 

images, as described in Chapter 4.
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he LCD screen lets you play back your pictures one-Tby-one or in groups of nine at a time. In playback 

mode, you can also erase selected pictures and customize 

playback features through the LCD screen menus. You can 

view your pictures on a television just as easily as on the 

camera’s screen. This chapter explains the following:

◗ Using playback mode

◗ Playing back pictures one by one

◗ Playing back multiple pictures

◗ Playing pictures as a slide show

◗ Turning off picture information

◗ Erasing images

◗ Playing back pictures on TV

Playing Back Photos
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Using the Playback Mode

When you use the LCD screen’s playback mode, you don’t 

have to have the camera’s lens turned on. You can save 

battery power by turning off the lens before you switch to 

playback mode. Follow these steps:

1 Slide the screen mode switch to Playback. The last 

photo you took appears on the LCD screen.

2 To access the screen menus, press the SELECT button. 

Blue menu icons appear at the top of the screen with the 

currently selected menu displayed in orange. 

The settings for this menu are displayed on the screen, as 

shown:

3 Press the  and  buttons to view the settings for 

other menus. The orange highlight indicates the 

currently selected menu.

You can choose from the following menus:

Settings (date, time, beep, LCD brightness, 

and multi-frame period). See pages 8-8 to 8-11 

for more information.

Information (turn off the display of 

information on played-back pictures). See 

page 3-5 for instructions.

screen switch
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Playback Mode (one at a time or groups of 

9 images). See page 3-4 for instructions.

Erase Photo (erase the currently displayed 

picture). See page 3-6 for instructions.

Photo Control (erase, lock, display memory 

information, or work with flash memory cards). 

See pages 3-6 to 3-11 and Chapter 10 for instructions.

Slide Show (play back pictures 

automatically). See page 3-5 for instructions.

Option Menu (install optional camera 

programs or print directly from the camera).

Language (select language for LCD display 

and menus). See page 1-12 for instructions.

4 To exit the menus, press the BACK button until the 

menu icons and settings disappear. (Depending on the 

menu, you may have to press this button several times to 

return to playback mode.)

5 When you’re finished with playback mode, slide the 

screen switch OFF.

Playing Back Pictures One by One

When you set the screen switch to Playback, you see the last 

picture you took on the LCD screen, along with the date, 

time, and picture information:

Press the  button to display the previous picture. You 

can continue pressing the button to view your pictures in 

order. Press  to move forward through your pictures.

image quality

date and 
time

frame 
number

number of photos taken
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Playing Back Multiple Pictures

You can play back your pictures in Multi mode to 

view small “thumbnail” versions of nine pictures at 

once. Make sure the screen switch is set to Playback, and 

follow these steps:

1 Press the SELECT button to display the screen menus. 

2 Press  twice to display the Playback Mode menu. 

3 Press the SELECT button again to choose the Multi 

setting, then press the BACK button to exit the menus. 

Thumbnail images of the last photos you took appear on 

the screen, with the currently selected image framed in 

white.

4 Press the the  and  buttons to move the white 

selection frame through the images on screen. When the 

frame reaches the first or last photo of the current group, 

the previous or next group of up to nine images is 

displayed.
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5 To switch back to displaying one picture at a time, 

follow steps 2 through 4 again, but choose the Normal 

setting on the Playback Mode menu.

Playing Your Pictures as a Slide 

Show

You can use the LCD screen to display your pictures 

automatically. Make sure the screen switch is set to 

Playback, and follow these steps:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Slide 

Show option.

3 Press the SELECT button again. The LCD screen 

begins playing back your pictures one by one.

To move forward or back through the photos manually, 

press the  or  button. To pause the slide show at 

a particular photo, press the SELECT button. Press 

SELECT again to resume the slide show.

4 To stop the slide show, press the BACK button. Press 

BACK again to return to normal playback mode.

Turning Off Picture Information

The LCD screen displays the time and date of each 

picture along with other information. You can turn 

off the information display if you want.

Make sure the screen switch is set to Playback, and follow 

these steps:

1 Press the SELECT button to display the LCD screen 

menus.
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2 Press the  or  button until you see the 

Information menu.

3 Press the SELECT button to turn information OFF. 

You can press it again to turn information back on.

4 To save your setting, press the BACK button.

You can also turn off information displayed in View mode. 

Set the screen switch to View and follow the steps above.

Erasing Images

The LCD screen provides two different methods for deleting 

images after you play them back: 

◗ You can delete the currently displayed picture

◗ You can select pictures for deletion or “lock” (protect) 

them from deletion

You can also erase photos through your software when the 

camera is connected to your computer. For instructions, see 

Chapters 4 and 5.

Erasing the Currently Displayed Picture

Make sure the LCD screen is set to Playback and 

the image you want to erase is displayed. Then 

follow these steps:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Erase 

Photo option.

3 Press the SELECT button. A message appears asking 

you to confirm that you want to erase the image. 

4 Press SELECT again to erase the image. 

5 Press BACK to return to Playback mode.
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NOTE

If you try to erase a locked photo , you see a warning message. 

Press the BACK button to exit the Erase Image menu. See 

pages 3-9 to 3-11 for instructions on locking and unlocking 

images in the camera.

Selecting Pictures to Erase

You select pictures to erase using the Photo Control 

menu. You can either select individual pictures, or 

choose to erase all the pictures in the camera. Using the same 

menu, you can select pictures to lock (protect from erasing) 

or lock all pictures. See pages 3-9 to 3-11 for information 

about locking and unlocking pictures.

TIP

Before you start, set the playback mode to Multi. This makes it 

easier to select images.

Make sure the LCD screen is set to Playback, and follow 

these steps to erase pictures:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Photo 

Control menu, then press the SELECT button to 

display the menu options:

3 Press the SELECT button to enter the Erase mode. The 

following menu is displayed:
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4 Press the  or  button to choose Select Photo 

or Erase All.

◗ If you chose Erase All, press the SELECT button. 

A message appears asking you to confirm that you 

want to erase the photos. Press the SELECT button 

to erase the photos; or press the BACK button to 

return to the Photo Control menu without erasing 

the photos.

◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  

button to move through the images in the camera until 

the photo you want appears on the screen.

6 Press the SELECT button. An orange frame appears 

around the image. If you want to erase other photos at 

the same time, use the  or  button to display 

them, then press the SELECT button to select them.

NOTE

To cancel the selection of a photo, simply press the 

SELECT button again.

7 When you have selected all the photos you want to erase, 

press the BACK button. A message appears asking you 

to confirm your selections.

8 Press the SELECT button to erase the images and return 

to the Photo Control menu.

NOTE

If there are locked photos in your camera, a message 

appears on the screen before the confirmation message. 

Press the SELECT button to erase only the unlocked 

images from the camera.

9 Press BACK until you return to normal playback mode.
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Locking Photos

The lock feature allows you to keep your photos from being 

accidentally erased. You can lock selected photos or all the 

photos in the camera. 

Make sure the LCD screen is set to Playback, then follow 

these steps to lock pictures:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Photo 

Control menu, then press the SELECT button to 

display the menu options:

3 Press the  button until the Lock mode is highlighted 

in orange, then press the SELECT button to enter the 

Lock mode. The following menu is displayed:

4 Press the  or  button to choose Select Photo 

or Lock All.

◗ If you chose Lock All, press the SELECT button. A 

message appears asking you to confirm that you 

want to lock all the photos. Press the SELECT 

button to lock the photos. Then press the BACK 

button until you return to normal Playback mode.

◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  

button to move through the images in the camera until 

the photo you want to lock appears on the screen.
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6 Press the SELECT button. A lock icon  appears next 

to the frame number. If you want to lock other photos, 

use the  or  button to display them, then press 

the SELECT button to select them.

NOTE

To cancel the selection of a photo, press the SELECT 

button again.

7 When you have selected all the photos you want to lock, 

press the BACK button. The following message appears:

8 Press the SELECT button to lock the images.

9 Press BACK until you return to normal playback mode.

Unlocking Photos

After you have locked some of your pictures, you can unlock 

selected photos or all the photos in the camera. 

Make sure the LCD screen is set to Playback, then follow 

these steps to unlock pictures:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Photo 

Control menu, then press the SELECT button to 

display the menu options:
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3 Press the  button until the Lock mode is highlighted 

in orange, then press the SELECT button to enter the 

Lock mode. The following menu is displayed:

4 Press the  or  button to choose Select Photo 

or Unlock All.

◗ If you chose Unlock All, press the SELECT 

button. A message appears asking you to confirm 

that you want to unlock all the photos. Press the 

SELECT button to unlock the photos. Then press 

the BACK button until you return to normal 

playback mode.

◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  

button to move through the images in the camera until 

the photo you want to unlock appears on the screen.

6 Press the SELECT button. The lock icon disappears 

from the screen. If you want to unlock other photos at 

the same time, use the  or  button to display 

them, then press the SELECT button to select them.

NOTE

To cancel the selection of a photo, press the SELECT 

button again.

7 When you have selected all the photos you want to 

unlock, press the BACK button. The following message 

appears:

8 Press the SELECT button to unlock the images.

9 Press BACK until you return to normal playback mode.
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Playing Back Pictures on TV

You can display your pictures on a regular television or VCR 

by using the video cable that came with your PhotoPC 600. 

TIP

You can videotape your pictures to share them without using a 

computer. After you connect the camera, press the Record button 

on your VCR and set the camera’s LCD screen to Slide Show.

Follow these steps to play back your pictures on TV:

1 Make sure the camera and TV (and VCR) are turned off.

2 Open the camera’s connector cover and connect the 

black end of the video cable to the Video Out port as 

shown:

3 Connect the yellow end of the cable to the video input 

port on the television or VCR:

4 Turn on the TV (and VCR) and switch to the correct 

video mode.

5 Slide the screen switch on your camera to Playback. 

The last picture you took appears on the TV screen. You 

can use all of the camera’s playback features when your 

pictures are displayed on TV.
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hen you’re finished taking pictures, you can connect W the camera to your computer and transfer the 

images. Then you can use the pictures in your letters, 

presentations, or just about anything you create on your 

computer. This chapter describes the following:

◗ Connecting the camera

◗ Transferring pictures with Image Expert

◗ Getting images into TWAIN applications

◗ Getting images that you can import

NOTE

If your computer has a Type II PCMCIA card slot, you can get 

pictures by copying them direcctly from a CompactFlash memory 

card. See Chapter 10 for instructions.

4   

Connecting the Camera

Note the following before you start:

◗ If you have the optional AC adapter, you can conserve 

battery life by using it when you connect the camera to 

your computer. See page A-1 for instructions.

The AC adapter should be available where you bought 

your PhotoPC 600. Or, see page A-2 for information on 

ordering an AC adapter through EPSON.

◗ The camera’s auto shut-off feature takes place after 

5 minutes of inactivity when the camera is connected to 

your computer. To turn the camera back on, close the 

lens cover and then open it again. (You can change the 

auto shut-off time period if you want. See pages 8-5 

to 8-6 for instructions.)

Getting Photos Into Your Computer
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◗ When you connect the camera, make sure your system is 

not exposed to sources of electromagnetic interference, 

such as stereo speakers or the base units of cordless 

telephones.

Connecting to a Windows PC

Make sure you have the serial cable that came with your 

camera. Before you start, turn off the camera, LCD screen, 

and your computer. Then follow these steps:

1 Locate a serial port on the back of your computer. You 

may have two serial ports labeled COM1 and COM2, or 

the ports may be labeled with icons. If you have two 

serial ports available, use COM1 (port 1) to connect 

your camera.

NOTE

If you have a 25-pin serial port, you can use a 9- to 25-pin 

adapter.

2 Line up the serial connector on the cable with one of the 

serial ports on your computer, and insert the connector. 

Then tighten the screws. 

3 Open the connector cover on the side of the camera.

.
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4 Depending on the type of cable you have, line up either 

the arrow or the flat side of the cable connector with the 

mark on the camera’s serial port. Then insert the 

connector.

5 Turn on the camera and your computer system. 

Connecting to a Macintosh

Make sure you have the long serial cable and short 

Macintosh adapter that came with your camera. Before you 

start, turn off the camera, LCD screen, and your Macintosh. 

Then follow these steps:

1 Locate the modem port  or printer port  on 

the back of your Macintosh. You can use either port to 

connect the camera.

NOTE

If you are sharing a serial port that you use for another 

device, make sure AppleTalk™ is turned off. Your Macintosh 

may not recognize the camera if AppleTalk is on.
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2 Connect the long cable to the short Macintosh adapter 

cable, then tighten the screws. 

3 With the arrow on the cable facing up, line up the cable 

connector with the port on your Macintosh. Then insert 

the connector.

.

4 Open the connector cover on the side of the camera, as 

shown on page 4-2.

5 Depending on the type of cable you have, line up either 

the arrow or the flat side of the cable connector with the 

mark on the camera’s serial port (as shown on page 4-3). 

Then insert the connector.

6 Turn on the camera and your Macintosh system.

Transferring Photos With Image 

Expert

PhotoPC 600 provides several different ways to transfer your 

pictures from the camera to your computer. The simplest 

method is to use the Image Expert software that came with 

your PhotoPC 600. This lets you view small thumbnail 

images of your pictures, and then quickly transfer them to an 

album (folder) on your hard disk drive.

If you haven’t installed your software, do it now, following 

the instructions on page 1-10. 

Macintosh 
adapter

popch4.fm5  Page 4  Tuesday, August 26, 1997  5:00 PM



Getting Photos Into Your Computer  4-5

A

B

4

NOTE

Although these instructions and the accompanying illustrations 

show Image Expert running under Windows 95, you can follow 

the same steps on a Macintosh, Windows 3.1, or Windows NT 

system.

1 Start Image Expert. Under Windows 95, click Start, 

and then point to Programs, PhotoPC 600, Image 

Expert.

If you’re using Windows 95, you see a Quick Tour 

screen like the following:

If you’re using a Macintosh or a different version of 

Windows, skip to step 3.

2 Click on any of the topics for an animated 

demonstration of what you can do with Image Expert 

and PhotoPC 600. 

To skip the tour and transfer your pictures, click Close. 

You see a window like the following:

Click to see 
the pictures 
in your 
camera.
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3 Click View Pictures in the Camera. You see a 

window displaying “filmstrips” of your images. (If you 

see an error message instead, follow the instructions on 

page 4-7.)

4 Click Get All to transfer all the images. You can also 

click an individual image to select it. The Get All 

button changes to Get Selected. 

NOTE

If you want to select more than one image, hold down the 

Shift key while you click. To deselect, click another image.

You see a Select Album window like the following:

Click to start 
transferring 
your photos.

Type here if you 
want to rename 
your album.

Type here if you 
want to rename 
your album.

Windows

Macintosh
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Image Expert will automatically create an album (folder) 

for your pictures with the current date as its name. You 

can type your own name for the album if you want, or 

choose an existing album. 

5 Click Open (or OK on a Macintosh) to begin 

transferring your pictures. A window like the following 

appears to show you the progress of each image.

6 When you’re finished, close the filmstrip window. You 

see a message asking if you want to delete all the files in 

the camera.

7 If you want to make room for more pictures in your 

camera, click Yes. Your pictures are displayed in an 

album of thumbnails. You can double-click an image to 

open it in Image Expert.

You can display your images one by one, edit, print, and 

copy them to diskettes, or place them in your documents and 

presentations. See the following chapters for instructions.

You can also use the Help menu for more information. If 

you’re using Windows 95, you can run the Quick Tour from 

the Help menu to learn more about the camera and your 

software.

What To Do if You See an Error Message

When you click the button to view images in the camera, 

you may see a message like the following:

Click if you want to stop 
transferring images.
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Follow these steps to get your camera connected correctly:

1 Make sure the camera is turned on and has not shut off 

automatically. If it has, turn it off and then back on 

again by closing and opening the lens cover.

2 Check the cable and make sure the connections are 

secure. Make sure the pins inside the connector are not 

bent.

3 Make sure your batteries have enough power, or your 

AC adapter is connected.

4 Click Retry. If you see the Connection Failed message 

again, click Setup. 

You see the following dialog box:

5 Select another port if necessary. In most cases, it is best 

to leave the Port setting at Auto because Image Expert 

can detect the camera connection automatically. 

If you have a serial device connected to one port and an 

internal modem on the other, you can try setting the 

Port to COM3 or COM4.

6 Select a slower speed. Image Expert automatically 

chooses the fastest speed that works with your system, 

but this may actually be too fast for the configuration of 

your port. Try setting the speed to 57600. You may 

need to experiment to choose the best speed.

7 When you are finished, click OK.
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Getting Images Into TWAIN 

Applications

If you use Photoshop or other TWAIN-compliant 

applications, you can transfer your pictures directly into your 

program from the camera. Follow these steps:

1 Start your application. 

2 Choose Import, then Select TWAIN Source (or 

Acquire, then TWAIN Select Source) from the File 

menu.

3 Choose PhotoPC 600 as the TWAIN source.

4 Choose Import, then TWAIN (or Acquire, then 

TWAIN Acquire) from the File menu. 

5 The EPSON Photo!2 screen appears, with “thumbnail” 

images of your pictures, as shown below. (If you see a 

Setup screen that says The Camera Is Not 

Responding, see page 4-12.)

Click to transfer 
your picture(s).

Click if you 
need help.
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6 Select the picture you want and click Get Photos to 

transfer the picture. Or, click Select All to transfer all 

the pictures.

7 Click Erase Photos if you want to remove the pictures 

from your camera.

8 If necessary, click Close to exit the Photo!2 screen and 

return to your application.

You see the picture or pictures in the work area.

Getting Images That You Can Import

Most methods of transferring images from the camera save 

your pictures as JPEG files. If your word processor or other 

application doesn’t support the JPEG format, you have to 

convert the files one by one. Or, you can use the export 

feature of EPSON Photo!2 to automatically convert the files 

as you transfer them. 

Follow these steps to transfer and export your pictures with 

EPSON Photo!2:

1 Start your EPSON Photo!2 software. Under 

Windows 95, click Start, and then point to Programs, 

PhotoPC 600, EPSON Photo!2.

You see a screen like the one below. (If you see a Setup 

screen that says The Camera Is Not Responding, see 

page 4-12.)

Click to transfer and 
convert picture(s).
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2 Click the picture you want, or click Select All.

3 Click the Export Photos button. The Save As dialog 

box appears:

4 Type a file name. If you’re transferring more than one 

image, the software will add numbers to identify each 

one.

5 Select the file type from the pull-down menu. You can 

choose any of the following formats:

◗ PICT (Macintosh only)

◗ JPEG

◗ Bitmap (BMP)

◗ PCX

6 Click Save. Your pictures are transferred one by one.

NOTE

You cannot open exported photos in EPSON Photo!2. Use 

Image Expert to view and edit the exported images.

7 Click Erase Photos if you want to remove the pictures 

from your camera.
Type a name 
for your 
photo(s).

Click to transfer 
and “export” 
photos.

Click if you want to 
choose a different folder.

Click to choose 
the file type.

Click if you want to 
create a new folder.
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Here are some of the additional things you can do with 

EPSON Photo!2:

◗ Select a picture and click Photo Info to display the 

image’s resolution and other settings, along with the 

date and time it was captured.

◗ Select the Folder tab and click Browse to locate 

and display pictures you have downloaded. You can 

then select a picture and click Upload Photos to 

transfer a picture from your computer to the camera 

or an optional memory card. See Chapter 9 for 

more information.

◗ Select the Controls tab to change camera settings 

or view a live preview and take pictures from your 

computer. See page 8-4 for more information.

◗ Select the Setup tab to set the camera’s date and 

time, or change your computer connection settings. 

See pages 8-7 to 8-8 for more information.

8 Click Close to exit EPSON Photo!2. 

You can now insert your pictures in documents and other 

projects. For instructions, see page 5-2.

What To Do If the Camera Is Not 

Responding

When you try to acquire pictures from the camera or start 

the EPSON Photo!2 application, you may see a screen like 

the following:
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Follow these steps to fix your camera connection:

1 Make sure the camera is turned on and has not shut off 

automatically. If it has, turn it off and then back on 

again by closing and opening the lens cover.

2 Check the cable and make sure the connections are 

secure. Make sure the pins inside the connector are not 

bent.

3 Make sure your batteries have enough power, or your 

AC adapter is connected.

4 Click Test Connection. If you see the same screen, 

continue with step 5.

5 Select another port if necessary. In most cases, it is best 

to leave the Port setting at Auto because EPSON 

Photo!2 can detect the camera connection automatically. 

If you have a serial device connected to one port and an 

internal modem on the other, you can try COM3 or 

COM4.

6 Select a slower speed. EPSON Photo!2 automatically 

chooses the fastest speed that works with your system. 

This may actually be too fast for the configuration of 

your port. Try setting the speed to 57600. You may 

need to experiment to choose the best speed.

7 Click Test Connection again. If you still don’t see 

your pictures, see Chapter 11 for more troubleshooting 

tips.
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Gardening Monthly
November 1998

Sunflowers
Sunflowers are big-leafed, sturdy plants that need
full sun and moist soils.  Seeds attract birds.
Perennial species grow rapidly, forming sizable
clumps that can become invasive.  Plant in large
gardens or parks.  Start by division or seed.  All
bloom in late summer and fall.

Recipe of the Month
Grilled Cactus Pads
*  1 pound cactus leaves        * Olive Oil

This is an interesting treat for a cookout.  Scrub cactus leaves
well with a vegetable scrubber to remove any spines that may
be on them.  With the end of a potato peeler cut around the
spiney nodules and remove them. Make sure that all are
removed.  Grill the leaves over charcoal or wood fire for 10
to 12 minutes on each side.  Thicker leaves may take slightly
longer to grill.  Brush leaves with oil occasionally while
grilling.  Serve hot.

New Next Month

Orchid Mania

Landscaping Page 2

Bulbs  Page 3

Book Reviews Page 4

Seeds        Page 5

Supplies        Page 6

Cactus Fever
Large, round or cylindrical cacti with deep
accordianlike ribbing and prominent spines
comprise this group of Mexican and Southwestern
U.S. natives.  They vary in size and shape, but all
are easy to grow and can reach 10 ft. tall and wide.
Spring and summer flowers bloom in pink or
yellow in a circle at the plant’s crown.  Don’t plant
where children are present.

-  Focus on Echinocatus

This print sample was created using actual 1024x768 pixel images taken with the EPSON PhotoPC 600 XGA color digital camera.  It was
printed with the EPSON Stylus Color 600 printer at 1440 dpi on EPSON Photo Quality Glossy Paper.

hotoPC 600 provides several methods for gettingP your pictures into presentations, letters, and other 

projects. You can drag and drop a picture from an Image 

Expert album into a document or presentation. You can also 

import an image into your application, or copy and paste it. 

If you’re using Windows 95, you can use the Camio™ 

Viewer to drag a picture directly from the camera and drop it 

into your project. This chapter describes the following:

◗ Importing images into documents

◗ Getting images with copy and paste

◗ Using drag and drop from an album

◗ Getting images with the Camio Viewer

Getting Your Photos Into Documents
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NOTE

Although most of the instructions and illustrations in this chapter 

apply to Windows 95, you can follow the same steps on a 

Macintosh or a different version of Windows.

Importing Images Into Documents

Once your pictures are transferred and saved on your hard 

drive, you can import them into your applications. You may 

need to convert your images if you didn’t export them from 

the camera (as explained on page 4-10) and your application 

can’t import JPEG files. You can use the Save As feature of 

Image Expert to convert image files.

NOTE

Your picture may display poor image quality after you import it. 

However, in most cases it will print correctly.

Follow these steps to import a PhotoPC 600 picture into 

your document:

1 Start your application.

2 Open the document where you want to use the picture.

3 Select the point where you want to place your picture.

4 Select Picture from the Insert menu. (In some 

applications you may need to select a different 

command, such as Import Picture, which is usually in 

the File menu.) 

An Insert Picture dialog box appears:
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5 Locate and select the image you want to insert. In some 

applications you can see a preview of your picture.

6 Click OK (or Insert, Import, or whatever command 

your application uses) to insert your picture. The picture 

appears in your document.

NOTE

In some applications, you can add a frame around the picture if 

you want to move it around on the page or resize it. In other 

applications, you create a frame first, and then place the picture in 

it. For instructions, see your application’s online help or 

documentation.

Getting Images With Copy and Paste

You can use this method to place a picture in just about any 

type of document or project. Follow these steps:

1 Open your picture in Image Expert.

2 Click the Copy button or select Copy from the Edit 

menu.

3 Start your word processor or other application.

4 Open the document where you want to use the picture.

5 Choose Paste (or Paste Special) from the Edit menu. 

A copy of the picture appears in your document.
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Using Drag and Drop From an Album 

(Windows only)

Once you have transferred your pictures into albums, you 

can easily drag and drop them into documents or or other 

projects.

NOTE

Dragging and dropping an image into a document works only with 

OLE-2.0-compliant applications, such as Microsoft Word, 

PowerPoint, WordPerfect, or Lotus SmartSuite. Depending 

on how well your application supports OLE 2.0, your images may 

not look as good when you drag and drop them as when you 

import them.

Follow these steps:

1 Start Image Expert as described in Chapter 4.

2 Click View Pictures from an Existing Album. 

Or, from the Image Expert screen, click the 

Open Album button  or select Open Album from 

the File menu. You see a dialog box like the following:

3 Locate the album you want and double-click the album 

name to open it. 

4 Start your word processor or other application.
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5 Open the document where you want to use the picture. 

You should have both the Image Expert album and the 

document displayed on your screen, as shown:

6 Click the image you want.

7 While holding down the mouse button, drag the image 

to the location where you want it in your document.

8 Release the mouse button. The picture appears in your 

project or document.

If you want to edit or modify the picture, just double-click 

on it to bring up the Image Expert menus and toolbar.

Getting Images With the Camio 

Viewer (Windows 95)

The Camio Viewer, which runs only under Windows 95, is a 

quick and easy way to get pictures from the camera. You can 

transfer all images to your computer, or just display the 

pictures in the camera. Then you can drag a picture directly 

into a presentation or document.

NOTE

Dragging and dropping an image with the Camio Viewer works 

only with OLE-2.0-compliant applications running under 

Windows 95. 
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First you need to connect the camera to your computer as 

described in Chapter 4. Then follow these steps:

1 Double-click the camera icon  on the right end of 

your Windows 95 Taskbar. 

You see the Camio Viewer Startup Options dialog box:

2 Choose one of the following options:

◗ View images in the Camera

Displays a filmstrip of your pictures. You can then 

select an image to drag and drop into a document or 

presentation. (The image will be embedded in your 

document, and will not be available as a separate 

file.)

◗ Copy all images from the Camera to the 

Computer

Transfers your pictures to an album (folder) on your 

hard disk drive. You can then select an image to 

drag and drop.

◗ Copy all images and delete them from the 

Camera

Transfers your pictures to an album (folder) on your 

hard disk drive and deletes them from the camera. 

You can then select an image to drag and drop.

3 Continue with the steps in one of the following sections, 

depending on the option you chose in step 2.

Click to see the 
pictures in your 
camera.
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To Drag and Drop a Picture Into a 

Document

Follow these steps if you chose View images in the 

Camera:

1 Click OK. Your pictures appear in a strip of thumbnail 

images: 

2 Open the application and document where you want to 

use the picture.

3 Click the picture you want to use. Without releasing the 

mouse button, drag the picture to your document. 

When your pointer is over the location where you want 

the picture to appear, release the mouse button. The 

picture is downloaded from the camera, and it appears 

in your document.

If you want to edit or modify the picture, just double-

click it to bring up the Image Expert menus and toolbar. 

For more information about the Camio Viewer, choose 

Quick Tour from the Image Expert Help menu.

NOTE

When you drag and drop with the Camio Viewer, your picture is 

not saved as a separate image file on your hard drive. You have to 

transfer your image first if you want it to be available as a 

separate image file.
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To Transfer Images Before Placing Them

Follow these steps if you chose Copy all images:

1 Click OK to copy your pictures to an album named with 

the current date. Or, type a new name for the album and 

click OK. Your pictures are transferred one by one. They 

appear in a strip of thumbnail images, as shown on the 

previous page.

2 Follow steps 2 and 3 in the previous section to drag and 

drop a picture into a document or other project.
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ou can use Image Expert albums to organize your Y pictures and display or print them in various ways. On 

Windows systems, you can also copy an album to diskette, 

and use your own pictures as your screen saver or desktop 

wallpaper. You may even be able to e-mail a picture directly 

from Image Expert. This chapter covers the following:

◗ Using albums to display and organize pictures

◗ Viewing picture information

◗ Printing photos and albums

◗ Displaying albums as slide shows (Windows only)

◗ Copying albums to diskette (Windows 95 only)

◗ Creating a screen saver or wallpaper from your photos 

(Windows only)

◗ Sending pictures by e-mail (Windows 95 only)

Working With Photos and Albums
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Using Albums

Image Expert albums provide a convenient way to access and 

view your pictures.

Here are some of the things you can do with albums:

◗ Use the Edit menu to rename or delete an album. 

◗ Add or remove pictures by moving them to or from 

another album.

◗ Change a picture’s name by clicking on it and typing a 

new name.

◗ Rearrange an album by selecting Sort By Name or 

Sort By Date from the View menu.

Organizing Pictures in Albums

Although Image Expert initially sorts your pictures by date, 

you can easily drag and drop images between albums to 

organize them by subject matter or in any way you want. 

Follow these steps to copy or move images from one album 

to another:

1 Open the album where the pictures are located and the 

album you want to copy the images to. If you want to 

create a new album, click the New Album button  

or select New Album from the File menu.

Click here to change a 
picture’s name.

new 
album

existing 
album

popch6.fm5  Page 2  Tuesday, August 26, 1997  5:13 PM



Working With Photos and Albums  6-3

A

B

6

2 Select the image or images you want to move or copy. 

Hold down the Ctrl (Option on Macintosh) or Shift 

key to select multiple images. 

3 To copy images, click inside one of the selected images 

and hold down the mouse button.

To move images, click inside one of the selected images, 

hold down the mouse button, and hold down the Shift 

key.

4 While holding down the mouse (and Shift key), drag 

the image(s) to the other album until it is highlighted.

5 Let go of the mouse button (and key). 

The images are copied or moved to the album. You can 

sort the pictures and save or rename the new album.

Viewing Picture Information

You can display information about any image file and the 

camera settings that were used to capture it. Follow these 

steps:

1 Click the picture to select it or open the image by 

double-clicking it.

2 Click the Properties button  or select Properties 

from the Image menu. You see information like the 

following:

All PhotoPC 600 images are captured as 24-bit JPEG files, including 
monochrome images.
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3 Click the Camera Settings tab to display information 

like the following:

4 Click another image to view its information, or close the 

Properties box.

Printing an Image

You can print your picture enlarged or actual size, and add a 

title or footer to the page. Follow these steps:

1 Open the image you want to print.

2 Click the Page Setup button  or choose Page 

Setup from the file menu. 

The Page Setup dialog box appears:

Click if you want to reposition your photo.

Click to see how your page will look.
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3 Set any of the following options and click OK:

◗ Click Fit to Page if you want to stretch your 

picture to fill the page. Your image may lose detail if 

you make it too large.

◗ Type in a title for the top of the page. Click the 

Font button to change the font properties.

◗ Choose what you want to appear at the bottom of 

the page from the Page Footer list. 

◗ If you want to change the position of your picture 

on the page, click the Margins tab and enter new 

values for the margins.

◗ Click Preview to see what your printout will look 

like.

4 Click the Print button  or choose Print from the File 

menu to print out your picture.

Printing an Album

You can print a contact sheet containing thumbnail images 

of all the pictures in your album, or you can set the number 

of pictures printed on each page. You can also add a page 

title or footer, and print identifying information for each 

picture. Follow these steps:

1 Open the album you want to print.

2 Click the Page Setup button  or choose 

Page Setup from the file menu. The album Page Setup 

dialog box appears:

Click to set 
font for 
labels, title, 
or footer.
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3 Set any of the following options and click OK:

◗ Choose Print Contact Sheet or Print Images.

For a Contact Sheet, Image Expert prints your 

pictures at thumbnail size and fits as many as 

possible on the page. 

If you choose Print Images, you can set the number 

of images you want printed on each page. 

◗ Select a label for the images. You can select from 

combinations of name, date, and time, or select 

none.

◗ Type in a title for the top of the page. 

◗ Choose what you want to appear at the bottom of 

the page from the Page Footer list. 

◗ If you want to change the position of your picture 

on the page, click the Margins tab and enter new 

values for the margins.

◗ Click Preview to see what your printout will look 

like.

4 Click the Print button  or choose Print from the File 

menu to print out your picture.

Additional Options for Windows

If you’re using Windows, you can take advantage of the 

following additional options for working with your albums 

and images:

◗ Displaying albums as slide shows

◗ Copying an album or image to a diskette 

(Windows 95 only)

◗ Setting an album as your screen saver 

(Windows 95 only)

◗ Setting an image as your desktop wallpaper

◗ Sending an image or album by e-mail directly from 

Image Expert (Windows 95 only)
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Displaying Albums as Slide Shows

When you display an album as a slide show, you can have it 

play automatically with various transition effects between 

images. Follow these steps:

1 Open your album.

2 Click the Slide Show button  or select 

Slide Show from the View menu. 

The first image appears on your screen with the slide 

show controls, as shown:

3 Click the Play button to see the slide show.

4 If you want to change the appearance of your slide show, 

click the Options button. The Slide Show Options 

dialog box appears:

5 Set any of the following options and click OK:

◗ To stretch your pictures across the whole screen, 

click Fit to Screen.

◗ To change the display period for each picture, 

change the number in the Seconds Between 

Pictures box.

play
stop

options

close
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◗ To play the slide show only once, click 

Continuous Repeat to deselect it.

◗ To hide the titles of your pictures, click Show 

Titles to deselect it.

◗ To turn off the fades and dissolves that play 

between pictures, click Show Transition Effects 

to deselect it.

6 Click the Exit button to stop the slide show.

Copying to Diskette

You can copy whole albums or individual images to 

diskettes. You can also include a player, so your friends and 

business associates can view your pictures on their 

computers. This makes your images and albums completely 

portable. Follow these steps:

1 Insert a diskette into your diskette drive.

2 Open the album you want to copy. 

If you only want to include some of your images, select 

the images you want to add. To select more than one 

image, hold down the Ctrl or Shift key.

3 Select Save to Floppy from the File menu. You see the 

following dialog box:

4 Make sure your floppy drive appears in the Copy 

images to: box.

5 If you want to include a slide show player to view the 

pictures make sure Include Slide Show Player is 

checked. 
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6 If you want to copy the whole album click Selected 

Images Only to deselect it. 

NOTE

If your album is too large for one diskette, you can copy it to 

multiple diskettes. When you copy the files to another 

computer, the album will be in one piece again. You can also 

use Zip™ disks or other large-format storage media. Make 

sure your diskette is not write-protected before you try to 

copy.

7 Click OK to copy your files.

Viewing the Pictures on Diskette

You can run the slide show from the diskette or install the 

slide show player on another computer. 

◗ To run the slide show, double-click the player. The 

pictures appear on your screen with the slide show 

controls, as shown on the right.

See page 6-7 for instructions on setting slide show 

options.

◗ To install the player, double-click the installer icon and 

follow the instructions on the screen.

Using an Album as a Screen Saver

It’s easy to make your own screen saver with your favorite 

pictures. Follow these steps:

1 Open the album you want to use.

2 Choose Set Screen Saver from the File menu. Image 

Expert asks you to confirm your choice.

play
stop

options

close
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3 Click Yes.

Windows will play a slide show of your album whenever 

your system is idle.

NOTE

The screen saver slide show doesn’t include controls. If you want 

to change the way your pictures are displayed, you have to use 

the screen saver settings in your Control Panel. See your 

Windows documentation or Help system for more information.

Setting an Image as Wallpaper

You can use one of your own pictures as the background for 

your desktop. Follow these steps:

1 Open the image you want to use, or select it in an 

album.

2 Choose Set As Wallpaper from the File menu. The 

dialog box on the right appears.

3 Choose Center to place your picture in the middle of 

the screen or Tile to fill the screen with copies of your 

picture.

4 If you want the image to be stretched across the whole 

screen, click Resize to fit screen.

5 Click Yes. (If you change your mind, click Remove 

Wallpaper.)

You can minimize Image Expert to see your new 

wallpaper.

Click to remove 
existing wallpaper.

popch6.fm5  Page 10  Tuesday, August 26, 1997  5:13 PM



Working With Photos and Albums  6-11

A

B

6

Sending Pictures by E-mail

You can send a picture directly from Image Expert if your 

e-mail application complies with the MAPI (messaging 

application programming interface) standard. For example, 

you can use Inbox or Microsoft Exchange. You need to set 

up Microsoft Exchange to work with your Internet service.

NOTE

If you can’t e-mail pictures directly from Image Expert, you can 

always send an e-mail message as you do normally and attach 

one or more image files.

Before you start, make sure your modem and Internet service 

are working correctly and your e-mail application is 

configured. Then follow these steps:

1 Select or open the image(s) you want to send. Some 

e-mail systems may limit the number of images you can 

send in a single message.

2 Choose Send from the file menu. You see the Choose 

Profile dialog box on the right.

3 Choose the profile you want to use. 

Click New if your Internet service has not been set up 

to work with Microsoft Exchange. For more 

information about setting up Microsoft Exchange, see 

your Windows documentation or help system.

4 Click OK. Your e-mail application opens, and the 

image(s) you selected appear as attachments.

5 Type the e-mail address where you’re sending the 

picture(s). You can also type in a subject heading and 

message if you want. 

6 When your e-mail is ready, click whatever button your 

application uses to send. The picture(s) are mailed. 

Your e-mail application closes, and Image Expert 

becomes active again.

Click to configure 
your Internet 
service for 
Microsoft 
Exchange.
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ou can edit your images to enhance their appearance, Y crop, rotate, and resize them, or create special effects. 

This chapter describes the following Image Expert features 

you can use to modify your images:

◗ Viewing and selecting

◗ Applying Quick Fix

◗ Correcting

◗ Cropping

◗ Resizing and changing resolution

◗ Rotating

◗ Flipping 

◗ Applying special effects

◗ Changing the number of colors

Editing Images

W.C. FRUIT FARMW.C. FRUIT FARM
Please
join us
for a
berry

picking
event
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Viewing and Selecting

When your image is displayed in an album, you can rotate it 

or do a quick fix. However, to use any other editing features, 

you need to open the image by double-clicking it or selecting 

Open Image from the File menu.

Before you edit your image, you may want to use the Zoom 

and selection tools on the left side of your screen.

◗ Click the Zoom tool, and then click anywhere on your 

image to enlarge your view. Hold down the Ctrl key and 

click to zoom out.

◗ Use one of the three selection tools to isolate a part of 

your image before you edit it. Click the tool, then click 

and drag on your image to select the portion you want to 

work on. 

◗ Click Select All to select your entire image or all the 

images in an album.

◗ Click Select None to deselect your image or images.

NOTE

For more information about any of the editing tools described in 

this chapter, use the Help menu. 

Applying Quick Fix

The easiest way to improve your image is to have Image 

Expert automatically “correct” it with the Quick Fix 

command. You can click the Quick Fix tool  or select 

Quick Fix from the Image menu.

Zoom

Select Rectangle

Select Ellipse

Select Freehand

Select all

Select none
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If you don’t like the results, simply select Undo Quick Fix 

from the Edit menu. (If you Quick Fix an image displayed in 

an album, you can’t undo it.)

Correcting

To fine-tune an image, click the Corrections tool  or 

choose Corrections from the Image menu. You see a dialog 

box like the following:

Click the tabs at the top of the screen to make these kinds of 

corrections:

◗ Brightness and Contrast

For adjusting the amount of light in your image and the 

difference between light and dark areas.

◗ Color

For correcting color casts and adjusting the balance of 

cyan (blue), magenta (red), and yellow in your picture.

◗ Hue/Saturation

For adjusting colors around the “color wheel,” the 

strength or purity of color, and the brightness of your 

image.

◗ Sharpness

For emphasizing or de-emphasizing edges.

◗ Equalization

For increasing detail in dark areas of your image.

Each dialog box “tab” includes sliders for quickly and easily 

correcting your image. Simply move the slide indicator left 

or right to make your edit.

Click and drag to adjust the 
division between the original 
and edited preview.
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The preview window shows your image with the original 

view on the left and the corrected image on the right. If you 

want to adjust the division between the original and edited 

image, click and drag the triangle below the image. You can 

also zoom in on your image to see more detail. 

◗ Click Apply to make your changes on the current “tab.” 

Your edited image becomes your new original and the 

slide indicators move to the center of the range. 

◗ Click OK to save the changes you made on all the 

Corrections tabs and return to the main screen. 

◗ Click Cancel to cancel the changes on the current tab 

and return to the main screen.

Cropping

If you want to save only part of your image, use the crop 

function to cut out the rest of the image. Follow these steps:

1 Open the image you want to modify.

2 Click one of the selection tools on the left side of your 

screen.

3 Click and drag the mouse over the area you want to save. 

A dashed border indicates the area you selected.

4 If you change your mind about which part of the image 

to crop, simply click anywhere in the image and repeat 

step 3.

5 Click the Crop tool  or choose Crop from the Image 

menu. The part of the image that was outside the dashed 

line disappears.

selected area
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Resizing and Changing Resolution

You can resize your image in two ways: changing the printed 

size, or changing the image size in pixels. You can also 

change the resolution or image quality. 

Choose Resize from the Image menu. You see a dialog box 

like the following:

NOTE

Fine and super fine images from your PhotoPC 600 have a 

resolution of 240 pixels per inch; standard quality images have a 

resolution of 144 pixels per inch.

Click the tab if you want to change the image size in pixels. 

You see a dialog box like the following:

If you change the size of the image in pixels, the physical size 

of the image also changes, but not the resolution. Follow 

these guidelines when you resize:

◗ To enlarge your picture and retain its quality, increase 

the image size in pixels until the rectangle in the preview 

window looks the right size. The file size of your image 

will increase at the same time.

These 
settings work 
together: if 
you change 
one, the 
others also 
change.

Uncheck if you want to 
distort your image.
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◗ To make an image smaller, you can simply change its 

physical size. The resolution automatically increases. 

Rotating

You can click the Rotate tool  to quickly rotate a picture 

to the right. (If you rotate an image displayed in an album, 

you can’t undo it.) 

For more options, select Rotate from the Image menu. You 

can choose one of the following:

◗ Left (90 degrees counterclockwise)

◗ Right (90 degrees clockwise)

◗ Exact (specify the degree of rotation)

◗ Free (interactive rotation, as described below)

If you want to experiment with rotation, choose Free and 

follow these steps: 

1 Click on your image and hold down the mouse. Your 

pointer turns into the rotation tool. 

A rectangular outline of your image and an arrow 

appear, as shown:

2 Move the pointer to rotate your image. 

3 Release the mouse when your picture is at the angle you 

want. 
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Flipping

You can reverse your image by selecting Flip Horizontal 

from the Image menu. This is useful for printing T-shirt 

transfers. Select Flip Vertical to turn your image upside 

down.

Applying Special Effects

To transform or distort your images in interesting ways, 

choose Effects from the Image menu. You see a dialog box 

like the following:

Click the tabs at the top of the screen to add these effects:

◗ Ripples

For an underwater effect. You can create whirlpool 

effects or just a slight distortion.

◗ Glass blocks

You can change the number and size of the blocks.

◗ Edges

To soften outlines and decrease the amount of details. 

You can also blend the image into a light or dark 

background. 

◗ Fisheye

To distort the center of the image, as if looking through 

a glass ball.

◗ Invert

To create a negative of your image.

Each dialog box “tab” includes sliders for applying the effect. 

Slide the indicator to the right to increase the distortion. You 

can combine several filters for even more unusual effects.
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The preview window shows your image with the original 

view on the left and the distorted image on the right. If you 

want to adjust the division between the original and filtered 

image, click and drag the triangle below the image. You can 

also zoom in on your image to see more detail. 

◗ Click Apply to make your changes on the current “tab.” 

Your distorted image becomes your new original and the 

slide indicators move to the center of the range. 

◗ Click OK to save the changes you made on all the Effects 

tabs and return to the main workspace. 

◗ Click Cancel to cancel the changes on the current tab 

and return to the main workspace.

Changing the Number of Colors

To convert the color format of your image, select Number 

of Colors from the Image menu. You can choose from the 

following:

◗ 24 Bit (Millions of Colors) 

The way your images are originally captured.

◗ 8 Bit (256 Colors)

For low-resolution display systems or certain types of 

software. 

◗ Grayscale (256 Shades of Gray)

For printing in black and white.

If you save your image as 8 Bit or Grayscale, you cannot 

switch back to 24 Bit color.

Unlike the other editing options, changing the number of 

colors applies to the whole image. You can’t change the 

number of colors for a selected area only.
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hen the camera is connected to your computer, you Wcan take pictures with a live preview on your 

computer screen to help you frame each shot. You can also 

set the camera’s clock and adjust a number of other settings 

from your computer. To further customize your camera’s 

operation, you can use the Camera Settings menus on the 

LCD screen. You can even install optional programs in your 

camera to add new functions, such as printing directly from 

the camera.

This chapter covers the following:

◗ Taking pictures from your computer

◗ Adjusting camera settings from your computer

8   

◗ Customizing settings with the LCD screen

◗ Uploading programs into the camera

NOTE

You can use either Image Expert or EPSON Photo!2 to take 

pictures from your computer, adjust camera settings, and transfer 

images. PhotoPC 600 allows you to choose the application that 

best meets your needs and preferences.

Taking Pictures From Your Computer

When you connect the camera and take pictures from your 

computer, you see a live preview of each shot before you 

capture it. You can control all the camera settings from your 

computer, and even set the shutter speed.

Using Custom and Advanced Features
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NOTE

If you have the optional AC adapter, you can save on batteries by 

using it when you connect the camera to your computer. The AC 

adapter should be available where you bought your PhotoPC 600, 

or you can order it from EPSON. See page A-1 for more 

information.

Follow these steps to take pictures from your computer:

1 Connect the camera to your computer as described in 

Chapter 4. 

2 Position the camera facing the subject. Using a tripod 

will give you the most control when setting up your 

shots. See page A-3 for instructions.

3 Turn on both your camera and your computer system.

4 Start Image Expert an described on page 4-4.

5 Click the Camera Controls button  or choose 

Controls from the Camera menu. 

You see a dialog box like the following:

NOTE

The camera’s auto shut-off feature remains in effect when 

the camera is connected to your computer, but it takes place 

after 5 minutes of inactivity. To turn the camera back on, 

close the lens cover and then open it again. 

Click to erase 
images in the 
camera.

Click to 
capture 
the image 
you see.
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6 Click Continuous Update to activate the live preview 

feature. The image you see is updated every 8 to 10 

seconds, depending on your connection speed. You may 

need to move the camera or your subject until you see 

the image you want to capture.

The colors in your live preview image may appear pale 

and washed-out. This will not affect the colors in your 

actual photograph.

You can click the Flash, Resolution, and Macro 

buttons on the screen to adjust these settings just as you 

would by using the buttons on the camera. For more 

information, see Chapter 2. 

NOTE

When the camera is connected to your computer, you can’t 

use any of the control buttons or the shutter button on the 

camera. You can operate these features only through your 

computer.

7 When your shot is ready, click Take Picture. The 

image is captured and processed. 

8 Click Close when you’re finished taking pictures from 

your computer. 

NOTE

The live preview feature will quickly drain your batteries. Make 

sure you turn it off as soon as you’re finished.

Using the Self Timer

You can use this feature to have your computer take a picture 

automatically, after a delay period that you can set. This 

allows you to take self-portraits and other specialized shots.

Follow these steps: 

1 Click Self Timer. You see the following dialog box:
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2 Enter a number for the delay period you want to use. 

You can set up to a 99-second delay.

3 Click Start/Stop to start the countdown and take the 

picture. The red timer light on the camera remains on 

for the delay period you entered. Then the light flashes 

rapidly for 2 seconds and the shutter is released.

The camera beeps and processes your picture.

Setting the Shutter Speed

Most of the time, PhotoPC 600 adjusts the shutter speed 

automatically. However, when you take pictures from your 

computer, you can adjust the speed manually. This lets you 

use special lighting effects and even take “stop-action” 

photos.

On the Camera Controls window, click the arrow and select 

the speed you want from the pull-down list. 

Taking Pictures with EPSON Photo!2

You can use your EPSON Photo!2 application to take 

pictures from your computer, in the same way as Image 

Expert. 

First, follow steps 1 through 3 on page 8-2. Then follow 

these steps:

1 Start EPSON Photo!2 as described on page 4-10.

2 Click the Controls tab. You see a dialog box like the 

following:
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3 Click Start to display the live preview.

You can click the Mode, Flash, Self Timer, and 

Macro buttons on the screen to adjust these settings just 

as you would by using the buttons on the camera. For 

more information, see Chapter 2. 

4 When your shot is ready, click Take a Picture. The 

image is captured and processed. 

5 Click Close when you’re finished taking pictures from 

your computer. 

The AutoStop Timer shuts off live preview after one minute 

to save battery power. You can set the timer from 30 seconds 

to 5 minutes. 

Adjusting Camera Settings From 

Your Computer

You can use either Image Expert or EPSON Photo!2 to 

change the following camera settings:

◗ Time

◗ Date

◗ Power down time (Auto Shutoff)

◗ Camera ID

◗ Connection Port

◗ Connection Speed

Changing Settings With Image Expert

In Image Expert, you can change settings when you are 

viewing pictures in the camera. Follow these steps:

1 Connect the camera to your computer as described in 

Chapter 4. 

2 Turn on both your camera and your computer system.
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3 Start Image Expert an described on page 4-4.

4 Click the Camera Setup button to display the Camera 

Setup dialog box, as shown below:

◗ Enter a new Camera ID if you want to change the 

default. This might be useful if you have more than one 

camera and you want to be able to have its ID recorded 

in your picture data.

◗ Type in the Computer Time and Camera Time 

boxes to change the time and date of either one. Or, 

click Set Camera to Computer Time to have your 

camera automatically synchronized to your computer.

◗ Enter new values in either of the Power Down Time 

boxes if you want to change the camera’s automatic 

shut-off period. 

◗ If you want to adjust your port settings, click the 

Camera Connection button. You see the Connection 

dialog box: 

◗ Select another port if you want to change your 

connection. In most cases, it is best to leave the 

Port setting at Auto because Image Expert can 

detect the camera connection automatically. 

◗ Select a different communication speed. Image 

Expert automatically chooses the fastest speed that 

works with your system. This may actually be too 

fast for the configuration of your port. You may 

need to experiment to choose the best speed.
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Changing Settings With EPSON Photo!2

When you’re using your camera with EPSON Photo!2, you 

can click the Setup tab to display the following dialog box:

You can change the Computer Connection settings as 

described on the right and then click the Test Connection 

button. 

◗ Select another port if you want to change your 

connection. In most cases, it is best to leave the Port 

setting at Auto because EPSON Photo!2 can detect the 

camera connection automatically. 

◗ Select a different communication speed. EPSON 

Photo!2 automatically chooses the fastest speed that 

works with your system. This may actually be too fast 

for the configuration of your port. You may need to 

experiment to choose the best speed.

◗ Click Test Connection to make sure your new settings 

work with your system.

◗ Click the Set Time button to change the camera’s time 

and date settings. 

You see a dialog box like the following:
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Enter new values for the settings, or click Copy from 

Computer to have your camera automatically 

synchronized to your computer. Click OK to return to 

the Setup dialog box.

◗ Enter a new Auto Shut-off Time if you want to 

change this setting. This is the idle period after which 

the camera turns off automatically when it is not 

connected to your computer. (If you set a power-down 

time in Image Expert, it overrides the auto shut-off time 

setting in EPSON Photo!2.)

◗ Enter a new Camera ID if you want to change the 

default. This might be useful if you have more than one 

camera and you want to be able to have its ID recorded 

in your picture data.

Customizing Settings With the LCD 

Screen

In addition to using your computer to customize 

camera settings, you can use the LCD screen 

Settings menu. This gives you another way to set the 

camera’s date and time. You can also turn the alert beep off, 

adjust the LCD brightness level, and set the shooting time 

for multi-frame photos. (See page 2-12 for details on the 

multi-frame photo format.) 

Follow these steps to access the Settings menu:

1 Set the screen switch to View or Playback.

2 Press the SELECT button to display the LCD screen 

menus.
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3 Press the  or  button until you see the Settings 

menu:

4 Follow the instructions below for the settings you want 

to change.

5 When you’re finished adjusting settings, press the 

BACK button to return to normal playback or view 

mode.

Setting the Camera Clock

Follow these steps to set the date (year, month, day) and the 

time (hour and minute).

1 With the Settings menu selected, press the SELECT 

button. Icons for each setting appear on the screen, with 

the clock icon highlighted in orange:

2 Press SELECT again to enter the clock setting mode.

3 Press the  or  button to select the portion of the 

time or date you want to adjust. The selected item turns 

orange.

4 Press the SELECT button again; the item turns red.
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5 Press the  button to increase the number, or the 

 button to decrease the number, until the item you 

want to adjust is correct. Then press the BACK button 

to save the setting. The item turns orange.

6 Repeat steps 3 to 5 until the date and time are correctly 

adjusted and saved. Press the BACK button again to 

return to the Camera Settings menu.

NOTE

You need to reset the time and date whenever you replace the 

camera's batteries. In this case, you can enter the clock setting 

mode directly rather than going through the Camera Settings 

menu. See page 1-13 for instructions.

Setting the Alert Beep

To turn the camera’s alert beep on or off, follow these steps:

1 With the Settings menu selected, press the SELECT 

button. Icons for each setting appear on the screen, as 

shown on 8-9.

2 Press the  button to select the beep setting icon .

3 Press the SELECT button to select ON or OFF. The 

current selection is highlighted. 

4 Press the BACK button to save your setting and return 

to the Settings menu.

Setting the LCD Brightness

To adjust the brightness of the screen, follow these steps:

1 With the Settings menu selected, press the SELECT 

button. Icons for each setting appear on the screen, as 

shown on page 8-9.

2 Press the  button until the brightness icon  is 

highlighted in orange. 

3 Press the SELECT button again.

4 Press the  or  buttons to adjust the screen 

brightness.

5 When you’re finished adjusting the screen brightness, 

press the BACK button to save your setting and return 

to the Settings menu.
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Setting the Multi-frame Shooting Time

You can use the Settings menu to adjust the total time the 

camera takes to shoot nine frames in the multi-frame format. 

See page 2-12 for more information about this special format.

1 With the Settings menu selected, press the SELECT 

button. Icons for each setting appear on the screen, as 

shown on page 8-9.

Press the  button until the multi-frame icon  is 

highlighted and the following options appear:

2 Press the SELECT button until the setting you want is 

highlighted.

3 When you’re finished adjusting the multi-frame period, 

press the BACK button to save your setting and return 

to the Settings menu.

Uploading Programs into the Camera

By uploading new programs into the camera, you can add 

unique functions to your PhotoPC 600. The EPSON Stylus 

Photo Direct Print Kit will allow you to print from the 

camera to the EPSON Stylus Photo printer, without a 

computer. See Appendix A for more information.

You can use the EPSON Photo!2 Program Uploader utility 

to install up to five optional programs from your PC or 

Macintosh to your PhotoPC 600.

one-half 
second

one 
second

two 
seconds

three 
seconds
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ou can connect your camera to a multimedia projector Y or television and show not just photos, but also text and 

graphics. The EPSON Photo File Uploader lets you transfer 

images from your computer to your camera. Anything you 

can display on your computer screen can be captured, 

converted, and uploaded. You can create and show a 

presentation without printing overhead transparencies or 

slides, and without a laptop computer.

This chapter explains the entire process, including the 

following:

◗ Uploading images to the camera

◗ Converting presentations

◗ Projecting your presentation

9   

Uploading Images to the Camera 

The EPSON Photo File Uploader software allows you to 

convert any image or presentation slide to the EPSON Photo 

file format and upload it to your camera or a CompactFlash 

memory card in your computer’s PCMCIA drive. 

You can upload images in 640 × 480 pixel, 1024 × 768 pixel, 

or 1024 × 384 pixel sizes. EPSON Photo File Uploader 

automatically converts images from their original size to 

whichever of these three sizes you choose.

Using Your Camera for Presentations
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Uploading Existing Images From Your 

Windows PC

Before you start, make sure the camera is connected to your 

computer, and both the computer and the camera are turned 

on. Then follow these steps:

1 Start the EPSON Photo File Uploader program. In 

Windows 95, click Start, and then point to Programs, 

PhotoPC 600, EPSON Photo File Uploader. You 

see a screen like the one on the right.

2 From the Folder list, locate the folder containing the 

images you want to upload. Double-click the folder to 

select it.

The images in the folder are listed in the File Name 

box.

3 Select the format of the images you want to upload from 

the File Type list. 

4 Select the images you want to upload in the File Name 

list. Then click the -> button. If you want to upload all 

the images in the list at once, click the >> button.

Check this box for helpful information.
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As you select files, they appear in the Selected Files 

List in the order they will be uploaded, as shown on 

page 9-3. This determines the sequence in which you 

can display the images. 

◗ To rearrange the uploading order, select the image 

you want to reorder, then click the ↑ or ↓ sort 

arrow.

◗ If you want to change your selection, click the <- 

button to remove selected files or click the << 

button to remove all the files from the Selected 

Files List.

◗ If you want to preview a selected image and confirm 

its size, click the Preview checkbox. 

5 For each file in the Selected Files List, choose an 

image size from the Image Size box. The File Uploader 

will resize your files during the transfer process.

If you want to save copies of the converted files on your 

computer, click the Save file to checkbox. Click 

Browse, then select the folder where you want to save 

the files. Click OK.  The folder you selected is displayed 

to the right of the Browse button.

6 Click Start. EPSON Photo!2 opens and displays the 

images you selected.

Depending on the number of images, you may have to 

wait a minute or so for EPSON Photo!2 to open.

size of 
previewed 
image in 
pixels
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7 Click Select All to select all the images, or select 

individual images by clicking the thumbnails in the 

image selection window.

8 Click Upload Photos. The Upload Photos dialog box 

appears. 

9 Click Camera to upload the images to your camera, or 

click Compact Flash Memory Card to upload to a 

memory card installed in your computer’s PCMCIA 

drive; then click OK. The images are uploaded to the 

destination you selected.

If you clicked the Save file to checkbox in step 5, the 

converted images are also saved to the folder you 

specified.

Uploading Images From Your Macintosh

Follow these steps to upload images to your camera from 

your Macintosh:

1 Make sure the camera is connected to the computer, and 

that both the computer and the camera are turned on.

2 Double-click the EPSON Photo File Uploader icon. 

The EPSON Photo File Uploader window opens:

3 Click Add. The Select Files dialog box appears. 

4 Double-click the folder containing the images you want 

to upload, then select each file you want to upload and 

click Select.

Check here for helpful information.

size of 
previewed 
image
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If you want to preview a selected image and confirm its 

size, click the Preview checkbox. It takes a few seconds 

longer to select images with previews displayed.

When you finish selecting image files, click Done to 

close the Select Files dialog box. The selected images 

appear in the Selected Files List in the order they will 

be uploaded. This determines the sequence in which you 

can display the images. 

◗ To rearrange the uploading order, select the image 

you want to reorder, then click Up or Down.

◗ To remove files from this list, select the file(s) and 

click Remove.

5 For each file in the Selected Files List, select an image 

size from the Image Size box. The File Uploader will 

resize your files during the transfer process. 

If you want to save copies of the converted files on your 

computer, click the Save file to checkbox before 

uploading the photos. Click Browse, then select the 

folder where you want to save the files. Click OK.  The 

folder you selected is displayed to the right of the 

Browse button.

6 Click Upload. A window opens to show you the 

progress of the file conversion. Then EPSON Photo!2 

opens and displays the images you selected.

7 Click Select All to select all the images, or select 

individual images by clicking the thumbnails in the 

image selection window. 

8 Click Upload Photos. The Upload Photos dialog box 

appears. 

9 Click Camera to upload the images to your camera, or 

click CompactFlash Memory Card to upload to a 

CompactFlash memory card installed in the PCMCIA 

drive of your Macintosh; then click OK. The images are 

uploaded to the destination you selected.

If you clicked Save file to in step 5, the converted 

images are also saved to the folder you specified.
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Converting Presentations

If you want to upload a presentation or document that is not 

saved as a standard image file, you can make a “screen 

capture” of your computer desktop with the file open. This 

lets you turn any document or presentation into a series of 

image files that you can convert and upload to the camera or 

to a memory card.

Windows users can make screen captures from within the 

EPSON Photo File Uploader utility; Macintosh users need 

to use the standard Macintosh screen capture function.

Capturing Windows Screens

Before you start, make sure the camera is connected to your 

computer, and both the computer and the camera are turned 

on. Then follow these steps:

1 Start the EPSON Photo File Uploader program as 

described on page 9-2. You see the EPSON Photo File 

Uploader window, as shown on page 9-2.

2 Click the Screen Capture tab. The Screen Capture 

dialog box appears:

3 From the Folder list, double-click the folder where you 

want to save the screen capture.

Set key combination to use for capturing screens.

Set the drive and folder for saving screen captures.

Popch9.fm5  Page 6  Tuesday, August 26, 1997  5:19 PM



Using Your Camera for Presentations  9-7

A

B

9

If you need to create a new folder for the images, click 

the New Folder button.

4 Specify the key combination you want to use for screen 

captures in the Hot Key setting box. Click the ALT, 

CTRL, or SHIFT checkbox, then select a key from the 

hot key list. The default hot key is F5.

5 Click Start to activate the key combination. When the 

key combination is activated, the Start button changes 

to a Stop button. The key combination remains active 

only for the current session. To deactivate the hot key 

combination, press the Stop button.

6 Start your application and open the file to the page or 

image you want to capture.

NOTE

The entire screen is captured, not just the active window. 

Make sure you maximize your presentation before you 

capture it. If you set your application to “slide show” mode 

(or the equivalent) you can capture just the image you want, 

without menus and other screen elements.

7 Press the hot key combination you selected. 

You can make as many screen captures as you’d like; 

simply open each file you want to capture and press your 

screen capture key combination again.

8 When you are finished, close your application and click 

the Stop button on the Screen Capture dialog box. The 

key combination you selected is erased.

If you want to upload your screen captures to the camera 

right away, click the Upload To Camera tab. The screen 

capture files appear in the File Name list. Then follow the 

uploading instructions starting with step 4 on page 9-2.

TIP

Presentations using large fonts (at least 18 point) work best.
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Capturing Macintosh Screens

EPSON Photo File Uploader for the Macintosh does not 

have a screen capture feature. However, you can make screen 

shots using your Macintosh system software, then use 

EPSON Photo File Uploader to upload the screen captures 

to your camera.

The procedure may be different depending on your 

Macintosh. See your computer manual for detailed 

instructions on making screen shots.

Make sure the camera is connected to your Macintosh, and 

both the computer and the camera are turned on. Then 

follow these steps:

1 Open the EPSON Photo File Uploader as described 

on page 9-6.

2 Start your application and open the file to the image you 

want to capture.

NOTE

The entire desktop is captured, not just the active window. 

Make sure you make your document window as large as 

possible before you capture it. If you set your application to 

“slide show” mode (or the equivalent) you can capture just 

the image you want, without menus and other screen 

elements.

3 Press the Command, Shift, and 3 keys on your 

computer keyboard at the same time. Your Macintosh 

names and saves the screen shot on your hard drive (not 

in a folder).

You can make as many screen shots as you’d like; simply 

repeat this step.

4 When you are finished, close your application.

To upload your screen shots to the camera, click the EPSON 

Photo File Uploader window to make it active, then follow 

the uploading instructions starting with step 3 on page 9-4. 
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Projecting Your Presentation

You can display the uploaded images on a multimedia 

projector, television, or other video output device. Use the 

video cable that came with your PhotoPC 600. 

Follow these steps:

1 Make sure your camera and video projector are turned 

off.

2 Open the camera’s connector cover and connect the 

black end of the video cable to the Video Out port as 

shown below: 

3 Connect the yellow end of the video cable to the video 

input port on the projector as shown on the right.

4 Turn on the video projector and switch it to video 

mode.

5 Slide the camera’s screen switch to Playback.

The last image that you uploaded into the camera is 

projected. If you are using the optional AC adapter, you can 

also see the image on the LCD screen.

You can use the camera’s slide show feature to play your 

images automatically, or play them one at time using the 

navigation buttons. You can use all of the camera’s other 

playback features to show your presentation.

 

EPSON/PowerLite 5000  -  File: VS-PROJ1.eps
W. Swanlund                       MOD> 12/16/96
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ou can use ATA-compatible CompactFlash memory Y cards (4MB and up) to increase the storage capacity of 

your PhotoPC 600 camera. You can copy photos from your 

camera to the card (and vice versa). 

It’s easy to install and remove memory cards from your 

camera. If your desktop or laptop computer has a Type II 

PCMCIA card slot, you can access images directly by using 

an optional PCMCIA adapter. 

NOTE

When you install a memory card, the camera stores and displays 

pictures on the card, rather than in its internal memory.

10   

CompactFlash memory cards and adapters should be 

available where you bought your PhotoPC 600 camera. 

EPSON recommends ATA-compatible CompactFlash cards 

manufactured by SanDisk or Simple Technology. For 

information, call (800) 4-SIMPLE.

This chapter covers the following:

◗ Installing a memory card

◗ Removing a memory card

◗ Getting images from a card to your computer

◗ Formatting a memory card

◗ Getting memory information

◗ Copying to and from a memory card

Using CompactFlash Memory Cards
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CompactFlash cards increase the camera’s picture storage 

capacity as shown in the table below. Each card adds the 

number of pictures shown to the number of pictures in the 

camera’s internal memory.

Installing a Memory Card

Before you start, make sure the camera and the LCD screen 

are turned off. 

Insert the card all the way into the memory card slot, as 

shown on the right. 

The number of pictures you can store in the memory card 

appears in brackets on the camera’s display panel.

NOTE

When a memory card is installed, you may notice a delay 

between the time you press the shutter button and when the 

camera beeps. To avoid blurring, make sure you hold the camera 

still until it beeps.

Number of pictures (minimum capacity)

Image Quality
Internal 

Memory

4MB 

Card

8MB

Card

12MB

Card

16MB

Card

Standard 50 58 119 179 240

Fine 16 19 39 59 80

Super Fine 7 8 17 25 34

Fine Panorama 33 39 79 119 160

Super Fine Panorama 14 16 34 51 68
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Removing a Memory Card

Make sure the camera and the LCD screen are turned off. 

Then follow these steps:

1 Slide the switch on the bottom of the camera to eject the 

memory card.

2 Remove the card by hand.

CAUTION

Never remove the card while the camera is accessing it. Data in 

the card may be lost or damaged. Avoid using or storing the card 

in dusty places, in direct sunlight, or in places that become 

extremely hot or humid.

Getting Images From a Card to Your 

Computer

A PCMCIA adapter allows you to access images stored on 

CompactFlash cards directly from your computer. To use 

this adapter, your computer must be equipped with a Type II 

PCMCIA memory card slot.

If you’re using a Macintosh, you must enable the PC 

Exchange extension software to access files on CompactFlash 

cards. See your Macintosh documentation for more 

information.

 

2

1
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Using a PCMCIA Adapter

Follow these steps to use an adapter:

1 Insert the memory card all the way into the adapter, as 

shown below:

2 Insert the adapter into your computer’s Type II 

PCMCIA slot:

Transferring Photos

Once the adapter and card are installed in your computer’s 

PCMCIA slot, you can transfer photos by simply copying 

them to your hard drive. This is the fastest way to get 

pictures into your computer.

◗ In Windows 95, use My Computer or the Windows 

Explorer to drag and drop image files to your hard drive.

◗ In Windows 3.1, use the Windows File Manager to copy 

image files to your hard drive.

◗ On a Macintosh, use the Finder to drag and drop image 

files to your desktop or hard drive.

NOTE

If you can’t access a card in your notebook computer, contact the 

computer manufacturer. For more information, see page 11-6.

Formatting a Memory Card

Most ATA CompactFlash cards are already formatted when 

you buy them. You only need to format a card if a message 

appears on the LCD screen instructing you to do so.
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With the memory card installed in the camera, follow these 

steps:

1 Set the screen switch to Playback. If you haven’t used 

the memory card, you may see the following message: 

This applies to the memory card only, and does not 

indicate whether you have photos in the camera’s 

internal memory.

2 Press the SELECT button to display the LCD screen 

menus.

3 Press the  or  button until you see the Photo 

Control menu . Then press the SELECT button to 

display the menu options, as shown on the right.

4 Press the  or  button until Format Card is 

highlighted.

5 Press the SELECT button. A message appears stating 

that all data on the card will be erased and asking you to 

confirm the procedure. 

6 Press the SELECT button again to format the card and 

return to the Photo Control menu.

7 Press BACK until you return to normal playback mode.

NOTE

If you are unable to format a Simple Technology card, contact the 

Technical Support Department at (800) 4-SIMPLE.
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Getting Memory Information

You can use the Photo Control menu to get 

information on the number of pictures taken and 

remaining in your camera’s internal memory and on an 

installed memory card. Make sure the screen switch is set to 

Playback and follow these steps:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Photo 

Control menu, then press the SELECT button to 

display the menu options:

3 Press the  button until Memory Info is highlighted 

in orange, then press the SELECT button. You see 

information displayed like the following:

4 Press BACK to return to the Photo Control menu. 

Continue pressing BACK to return to normal playback 

mode.

number of 
photos you 
can take

number of 
photos stored in 
camera and card

total photos 
you can store 
at current 
image quality
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Copying to and From a Memory Card

When a memory card is installed in your camera, you can 

copy photos between the camera’s internal memory and the 

memory card. Before you start, make sure the screen switch 

is set to Playback. You might find it easier to select images if 

you set the playback mode to Multi. See page 3-4 for 

instructions. Then follow these steps:

1 Press the SELECT button to display the LCD screen 

menus.

2 Press the  or  button until you see the Photo 

Control menu. Then press the SELECT button to 

display the menu options:

3 Press the  or  button until Copy is highlighted 

in orange, then press the SELECT button to enter the 

Copy mode. The following menu is displayed:

4 Press the  or  button to copy photos from the 

camera to the card, or from the card to the camera.

5 Press the SELECT button, then press the  or  

button to move forward or back through the images in 

the camera until the photo you want to copy appears on 

the screen. 

6 Press the SELECT button. An orange frame appears 

around the photo. If you want to copy several photos at 

the same time, use the   or  button to display 

them and press the SELECT button each time.
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NOTE

To cancel the selection of a photo, simply press the 

SELECT button again. If you select more photos than the 

card or camera can hold, an error message appears.

7 When you have selected all the photos you want to copy, 

press the BACK button. A message appears asking you 

to confirm your selections.

8 Press the SELECT button to copy the images and return 

to the Photo Control menu.

9 Press BACK until you return to playback mode.
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Maintenance and Troubleshooting

.

our PhotoPC 600 camera is easy to take care of, andY any problems you may have are easy to solve. This 

chapter includes the following sections:

◗ Caring for the camera and battery charger

◗ Solving camera problems

◗ Solving picture problems

Caring for the Camera and Battery 

Charger

Your PhotoPC 600 requires only basic care. Before you 

perform any maintenance procedures, be sure to read the 

Safety Instructions in the Introduction. Then follow these 

guidelines:

11   

Cleaning the Camera and Battery Charger

◗ Use a clean, dry cloth to wipe the camera free of dust.

◗ Use a damp cloth for cleaning the battery charger.

◗ Unplug the battery charger before cleaning.

◗ Keep the battery charger terminals clean by wiping them 

with a dry cloth.

◗ Don’t use harsh or abrasive cleaners. Don’t use liquid or 

aerosol cleaners.

◗ To clean the lens, first blow off any loose dust or dirt. 

Then breathe on the lens and wipe off all moisture with 

a soft, lint-free cloth or lens cleaning tissue. To avoid 

scratching the lens, don’t press too hard.
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◗ If necessary, clean the battery contacts with a dry cloth.

◗ If the LCD screen gets fingerprints or smudges on it, use 

a soft, damp cloth to lightly wipe the screen. 

Storing the Camera

◗ Keep the lens covered (power turned off) and store the 

camera in a carrying case or bag when you’re not 

using it. 

◗ When the camera is not used for long periods of time, 

remove the batteries and store them at a low temperature 

in a dry location. This prevents camera damage from 

battery leaks or corrosion.

Do not store the camera in the following locations:

◗ Where it will be exposed to direct sunlight, for example, 

on a car dashboard

◗ Near bright sources of light or high humidity

◗ Near heat sources or in a closed car or trunk

◗ In areas of excessive dirt or dust

◗ Where it will be exposed to strong vibrations or 

magnetic fields

Solving Camera Problems

Before you call for help, check this list of problems and 

possible solutions:

The camera has no power.

◗ Make sure the lens cover is open all the way.

◗ The camera may have shut off automatically. Close and 

open the lens cover to turn the power back on.

◗ Check the batteries and make sure they are installed 

correctly. Recharge or replace the batteries.

◗ If you are using the AC adapter, make sure it is plugged 

into a working outlet.
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You can’t take a picture with the camera.

◗ The flash may be recharging. Wait until the status light 

turns green, and try again.

◗ The camera may be full. Check the picture counter on 

the display panel. Erase some pictures (see Chapter 3), 

or transfer the pictures to your computer and then erase 

them (see Chapter 4). Or, install a CompactFlash 

memory card to store more pictures (see Chapter 10). 

◗ The camera may be connected to your computer. When 

it’s connected, you can’t use any of the controls on the 

camera itself. See Chapter 8 for instructions on taking 

pictures from your computer.

The flash doesn’t work.

◗ Make sure the flash is not set to the flash off setting.

◗ Check the batteries and make sure they are installed 

correctly. Recharge or replace the batteries if necessary.

◗ You can’t use the flash when you adjust the shutter 

speed manually with the camera connected to the 

computer. Set the shutter speed to automatic to use the 

flash. 

Your LCD screen flickers.

◗ Check the lights around you. The screen may appear to 

flicker under fluorescent light. This does not affect your 

picture quality.

Nothing appears on the LCD screen.

◗ If you’re using View mode, make sure the power is on.

◗ Check your batteries and make sure they are installed 

correctly. Recharge or replace the batteries if necessary.

The image on the screen is too dark.

◗ Adjust the brightness of the screen using the Settings 

menu. See page 8-10 for instructions.

Popch11.fm5  Page 3  Tuesday, August 26, 1997  4:48 PM



11-4   Maintenance and Troubleshooting

The “pictures remaining” number on the display panel 

doesn’t decrease after you take a picture.

◗ Your camera is operating correctly. The total number of 

pictures you can store depends on your pictures’ 

content. So the number doesn’t always change, 

especially when you’re using standard image quality.

You get an error message when you try to transfer your 

pictures to the computer.

◗ Make sure the cable is connected correctly as described 

in Chapter 4.

◗ Make sure your camera is turned on and the batteries 

have enough power.

◗ Check the serial port settings in your Image Expert or  

EPSON Photo!2 software. You may need to change the 

Port and Speed serial connection settings to Auto.

◗ Make sure the port to which your camera is connected is 

properly configured and that the Base I/O port address 

and the Interrupt Request Number (IRQ) assigned to 

the port are not in conflict with any other devices.

◗ Check the port setting in your Windows Control panel. 

You may need to set your port to a faster speed, lower 

the FIFO buffer size (advanced serial port 

configuration), or adjust the speed in your software. See 

Chapter 8 for more information.

◗ If you’re using a Macintosh and the camera is sharing a 

serial port with another device, make sure AppleTalk is 

turned off. 

◗ Make sure you don’t have both Image Expert and 

EPSON Photo!2 open at the same time.

You get an error message when you’re using your 

PhotoPC 600 software with the camera connected to your 

computer.

◗ Make sure the cable is connected correctly as described 

in Chapter 4.

◗ Make sure your camera is turned on and the batteries 

have enough power.

Popch11.fm5  Page 4  Tuesday, August 26, 1997  4:48 PM



Maintenance and Troubleshooting  11-5

A

B

11

◗ Check the serial port settings in your Image Expert or  

EPSON Photo!2 software. You may need to change the 

Port and Speed serial connection settings to Auto.

◗ Avoid opening or working with other software 

applications while the camera and computer are 

communicating.

You are unable to drag and drop photos into a document.

◗ If you’re using Windows 3.1, this method of getting 

pictures into your documents may not be reliable. Try 

importing or using copy and paste.

◗ If your system has less than 16MB RAM, you may not 

be able to use drag and drop. Make sure you don’t run 

too many applications at the same time. You may need 

to add memory to your system or use another method of 

getting photos into your documents.

You are unable to copy and paste or import your photo into 

a document on your Macintosh. 

◗ Try increasing your virtual memory using the Memory 

Control Panel.

◗ Increase the memory allocation for your word processor 

or other application. (Select the application and choose 

Get Info from the File menu.)

◗ Try turning off any extensions that are unnecessary. See 

your computer documentation or online help for more 

information about changing memory settings and 

turning off extensions.

The pictures transfer to your computer too slowly.

◗ If your system has less than 16MB RAM, the transfer 

speed may be slow. Try using virtual memory. See your 

computer documentation or system help for more 

information.

◗ Check the port setting in your Windows Control panel. 

You may need to set your port to a faster speed. See your 

Windows documentation or help system for more 

information.
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You get an error message when you use the Image Expert 

Save to Floppy feature.

◗ Make sure the diskette you’re using is not write-

protected.

You get a TWAIN error message when you try to transfer 

images with Adobe® Photoshop.

◗ If you’re using Windows 3.1, make sure you select 

TWAIN (not TWAIN-32) as your source.

◗ If you’re using Windows NT 4.0, you may need to 

upgrade your software to Photoshop 4.0. Earlier versions 

of Photoshop do not support Windows NT 4.0.

You are unable to format or use a CompactFlash memory 

card with your camera.

◗ Make sure you’re using an ATA-compatible 

CompactFlash card. Other cards may not work with 

PhotoPC 600. If you’re using a Simple Technology 

card, call the Technical Support Department at 

(800) 4-SIMPLE.

Your notebook computer can’t access a memory card.

◗ If you’re using an IBM Thinkpad,™ you need to adjust  

your port setting. In the Windows Control Panel 

(System Device Manager), change the Global Settings 

for your PCMCIA port to Auto. For more information, 

contact your computer manufacturer.

When you upload pictures to a memory card in your 

computer, your system appears to hang.

◗ Check the status bar at the bottom of your screen. If it 

shows that the transfer is complete, your system is 

operating correctly. You may have to click your mouse 

to change the hourglass icon to a normal pointer.

When you copy image files from your computer to a 

memory card in your PCMCIA drive, the camera can’t 

access the images.

◗ You can’t use this method to upload pictures to the 

camera. You have to use the EPSON Photo File 

Uploader to convert and upload your images.
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Solving Picture Problems

If you’re not satisfied with some of the pictures you get from 

the PhotoPC 600, you may need to adjust some of the 

camera settings. Read the suggestions below.

Your pictures display poor image quality on the screen or 

when you print them out.

◗ PhotoPC 600 captures images in 24-bit color 

(16.7 million colors). Your pictures will not display 

maximum image quality if your monitor or computer’s 

video controller doesn’t support this color depth. You 

may need to upgrade your system to achieve the best 

possible image quality.

◗ If your pictures look better on the screen than when you 

print them out, you may need to upgrade your printer. 

An EPSON color ink jet printer, for example, provides 

excellent image quality.

◗ If you used drag and drop to insert your pictures, they 

may appear grainy. Try importing them into your 

documents instead.

The colors in your picture don’t look right.

◗ When you take pictures under certain artificial lighting 

conditions, the colors may be slightly distorted. You can 

use your Image Expert software to adjust the colors, as 

described on page 7-3.

Your picture is blurry or out of focus.

◗ Make sure your subject is within the camera’s range. You 

should be at least 2 feet away to take a picture without 

the flash, and 8 inches to 8 feet away to take a picture 

with the flash.  You can take a picture as close as 8 inches 

in macro mode.

◗ Make sure you hold the camera steady, and your subject 

isn’t moving.

◗ If you want to photograph a moving subject, you can 

change the shutter speed while the camera is connected 

to your computer. Try increasing the shutter speed. For 

more information, see Chapter 8.

◗ Make sure your flash is not set to flash off.
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◗ When you focus on a nearby object, your picture’s 

background may appear blurry. Try changing your 

focus.

Your picture is too dark (underexposed).

◗ You may need to use the flash. Make sure the setting is 

not flash off.

◗ If you’re using the flash, make sure your subject is within 

the range of 8 inches to 8 feet. 

◗ Use Image Expert to adjust the picture’s brightness and 

contrast as described on page 7-3.

◗ If you’re using the macro mode to take a close-up photo, 

be sure to provide adequate lighting for your subject, 

since the camera’s smallest aperture setting (F8) is 

automatically selected in this mode.

Your picture is too light (overexposed).

◗ If you’re using the forced flash setting, it may be too 

bright. Try setting the flash to Auto.

◗ If you’re facing a bright light source, you may need to 

shoot your picture from a different angle.

◗ Use Image Expert to adjust the picture’s brightness as 

described on page 7-3.

Part of your picture is missing.

◗ Make sure you’re not blocking the lens with your finger, 

hand strap, clothing, or other object.

A horizontal or vertical red line appears on your picture.

◗ Red lines are caused by glare. Avoid photographing 

shiny surfaces that reflect excessive amounts of light into 

your lens. 

The wrong date and/or time are displayed on your pictures.

◗ Whenever you change the batteries in your camera you 

need to reset the clock. You can use the LCD screen 

Settings menu or set the camera’s clock from your 

computer. See Chapters 1 and 8 for more information.
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Your pictures don’t look as good as they used to.

◗ Your camera’s lens may be dirty or dusty. Try cleaning it 

by following the instructions on page 11-1.

The area captured in the photo is different from what you 

saw in the viewfinder.

◗ Make sure you look straight through the viewfinder. 

Keep in mind that the area visible through the 

viewfinder is slightly smaller than the area captured in 

the photo.

◗ If you’re taking a close-up or macro mode picture, use 

the LCD screen.
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        ou can use the PhotoPC 600 with a variety of options.YTo save battery power, you can use the AC adapter. For 

portraits or other studio photographs, you can attach a 

tripod to your camera. You can also get replacement NiMH 

batteries or a replacement NiMH Power Pak.

To increase your camera’s picture storage capacity and add 

flexibility, you can use CompactFlash memory cards and 

PCMCIA adapters. EPSON recommends cards 

manufactured by SanDisk or Simple Technology 

(800-4-SIMPLE). For information on using memory cards, 

see Chapter 10.

The EPSON Stylus Photo Direct Print Kit comes with 

everything you need to print directly from the camera to the 

EPSON Stylus Photo printer: software on a CD-ROM, 

A   

AC adapter, and cable for connecting your camera to the 

printer.

This chapter includes the following instructions:

◗ Using the AC adapter

◗ Using a tripod

The AC adapter and EPSON Stylus Photo Direct Print Kit 

should be available where you bought your PhotoPC 600. 

You can also order them from EPSON Accessories at 

(800) 873-7766 (U.S. sales only). In Canada, call 

(800) 873-7766 for dealer referral.

Optional Accessories
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Using the AC Adapter

The AC adapter (B867038) allows you to connect your 

PhotoPC 600 to any standard electrical outlet. This is 

especially useful when you are transferring pictures and 

operating the camera from your computer. The adapter 

powers the camera but does not charge the batteries.

WARNING

◗ Use only the adapter designed for the PhotoPC 600. Using any

other adapter may cause fire, electrical shock, or injury.

◗ Do not alter the plug on the power cable, and do not use the 

adapter for any other purpose than powering your PhotoPC 600.

To avoid losing any images or settings, make sure the camera 

is finished processing. Turn the camera off before you 

connect or disconnect the AC adapter. Then follow these 

steps:

1 Open the connector cover on the side of the camera.

2 Plug the adapter cable into the DC port on the camera.

3 Plug the AC adapter into an electrical outlet.

Accessory Product code

PhotoPC 600 AC adapter B867038

EPSON Stylus Photo Direct Print Kit A883191

NiMH Battery Pak B818061

NiMH Power Pak B818051
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Using a Tripod

You can use your PhotoPC 600 with any standard tripod. 

Follow these steps:

1 Assemble and set up the tripod by following the 

manufacturer’s instructions. Make sure the tripod is 

well-balanced on a flat surface.

2 Find the opening for the tripod screw on the bottom of 

your camera. Carefully place the camera on the tripod. 

Screw the camera on until it is firmly in place.

3 Adjust the tripod to view your subject as desired.
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Camera

Physical Dimensions

Safety Specifications

Width 5.6 in (142.5 mm)

Height 2.75 in (69.8 mm)

Depth 1.9 in (48.8 mm)

Weight 0.5 lb (under 250 g), without 
batteries

FCC approval code  BKMFBG660A

B   

Power
Sources 4 AA batteries (single-use alkaline or 

lithium or rechargeable NiCad or
NiMH)

Optional AC adapter (B867038)

Battery Life At least 400 pictures can be taken before 
the standard NiMH batteries need 
recharging (without the LCD screen or 
flash) 

Specifications
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Technical

Environmental

Product type CCD (charged coupled device)
still frame auto focus camera

Image size 1024 × 768 pixels (fine and super fine)
640 × 480 pixels (standard and multi)
1024 × 384 pixels (panoramic)

DPI 144 standard and multi
240 all other settings

Bit depth 16 million colors, 24-bit

Lens 5-element aspherical glass lens

CCD 1/3 inch color area CCD (810,000 pixels)

Serial interface 8-pin mini-DIN (to camera), 
RS-232C-compatible (to computer)

Serial 
communication 
speed

Up to 115Kbps

Video out NTSC standard

Internal memory 4MB flash memory

Optional expansion 
memory

CompactFlash cards from 4MB to 16MB
(available from SanDisk and Simple 
Technology)

Temperature Operating:  32 to 104°F (0 to 40°C)
Non-operating: -4 to 140°F (-20 to 60°C)

Humidity Operating: 30 to 90% (non-condensing)
Non-operating: 10 to 90% (non-
condensing)
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Photographic
Lens f = 5 mm F2.8 (equivalent to a 36 mm 

lens on a 35 mm camera)

Range 20 inches (50 cm) to infinity
8 inches to 20 inches (20 cm to 50 cm)  
(macro mode)

LCD screen 2-inch active matrix TFT color LCD 
(110,000 pixels)

Sensitivity Equivalent to ISO 100

Exposure control Program auto exposure

White balance TTL automatic white balance

Shutter Electric iris with mechanical shutter, 
1/8 second to 1/500 second (flash off 
mode)

1/30 second to 1/500 second (auto flash 
and forced flash modes)

Viewfinder Optical, with centering crosshair and 
edge border

Focus Auto focus

Aperture F2.8, F5.6, F11 automatic change

Flash Automatic luminance control flash

Flash modes Forced flash, automatic, flash off

Flash range 8 inches to 8 ft (0.2 to 2.4 m)
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NiMH Battery Charger

Physical Dimensions

Technical

Optional AC Adapter

Physical Dimensions

Technical

Width 3.0 inches (76 mm)

Height 4.41 inches (112 mm) 

Depth 0.87 inches (22 mm)

Weight Approximately .24 lb (110 g)

Input 120V AC, 60 Hz

Output DC 1.2V/650mA × 4

Charging time Approximately 160 minutes

Power consumption Approximately 8W

Charging 
temperature

32 to 95°F (0 to 35°C)

Width 1.97 inches (50 mm)

Height 1.18 inches (30 mm) 
1.85 inches (47 mm) including pins

Depth 3.74 inches (95 mm)

Output DC 7V/2.0A

Input 110 to 120 V AC, 50 to 60 Hz
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Index

A

AC adapter, 3, 2-3, 4-1, A-1 to A-2, B-4
Accessories, 3, A-1 to A-2
Acquiring photos, TWAIN programs, 4-9 to 4-10
Adjusting camera settings, 2-6 to 2-9, 8-5 to 8-11
Albums

copying to diskette, 6-8 to 6-9
displaying as slide show, 6-7 to 6-8
dragging pictures from, 5-4 to 5-5
making screen saver, 6-9 to 6-10
organizing pictures, 6-2 to 6-3
printing, 6-4 to 6-6
using, 6-2

Alert beep, setting, 8-10
AppleTalk, 4-3
Attaching hand strap, 1-9
Automatic shut-off, 2-2, 8-2, 8-6, 8-8

B

Batteries
charging, 1-4 to 1-6
checking, 2-3
handling, 1-8 to 1-9
installing, 1-6 to 1-7
specifications, B-1

Battery icon, 2-3
Beep, setting, 8-10
Bitmap (BMP) files, 4-11
Brightness

correcting images, 7-3 to 7-4
setting LCD, 8-10

C

Cable
serial, 4-2 to 4-3
video, 3-12, 9-9
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Camera, see PhotoPC 600 camera
Camio Viewer, 5-5 to 5-8
Caring for camera, 11-1 to 11-2
CD-ROM, installing software, 1-10 to 1-12
Charging batteries, 1-4 to 1-6
Cleaning camera, 11-1 to 11-2
Clock, setting, 1-13 to 1-14, 8-9 to 8-10
Close-up pictures, 2-6
Color correcting, 7-3 to 7-4
Color depth, 7-8
CompactFlash memory cards

capacity, 10-2
copying images, 10-7 to 10-8
formatting, 10-4 to 10-5
information, 10-6
installing, 10-2
problems, 10-5, 11-6
removing, 10-3
transferring images, 10-3 to 10-4
uploading images to, 9-1 to 9-5

CompuServe, 4
Computer, connecting camera, 4-1 to 4-4

Contrast, correcting, 7-3 to 7-4
Copying pictures

into documents, 5-3
to and from memory cards, 10-7 to 10-8
to diskette, 6-8 to 6-9

Cropping images, 7-4

D

Date, setting, 1-13 to 1-14, 8-9 to 8-10
Direct Print Kit, 8-11
Diskettes, copying pictures, 6-8 to 6-9
Diskettes, software installation, 1-10 to 1-12
Display panel, 2-3
Distorting images, 7-7 to 7-8
Documents, getting pictures into, 5-1 to 5-8
Download Service, 4
Downloading pictures, 4-4 to 4-12, 5-5 to 5-8
Drag and drop, 5-4 to 5-5, 5-7

E

Edges, softening, 7-7
Editing images, 7-1 to 7-8
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Environmental specifications, B-2
EPSON

Electronic support services, 4 to 5
help, 4 to 5
registration, 5
World Wide Web site, 4

EPSON Photo File Uploader, 9-1 to 9-9
EPSON Photo!2

installing, 1-10 to 1-12
support, 5
using, 4-10 to 4-13

EPSON Photo!2 Program Uploader, 8-11
EPSON Stylus Photo Direct Print Kit, 8-11
Equalization, 7-3
Erase Photo menu, 3-3
Erasing pictures from camera

using computer, 4-7, 4-10, 4-11, 5-6
using LCD screen, 3-6 to 3-8

Error messages, 4-7 to 4-8, 4-12, 11-4, 11-6
Exporting images, 4-10 to 4-11

F

FaxAdvice service, 4
Files

BMP, 4-11
converting during transfer, 4-10 to 4-12
JPEG, 4-10 to 4-11, 5-2
PCX, 4-11
PICT, 4-11
resizing, 7-5 to 7-6
uploading, 9-1 to 9-5
viewing information, 6-3 to 6-4

Fisheye effect, 7-7
Flash, 2-6 to 2-7
Flipping images, 7-7
FTP, 4

G

Glass blocks effect, 7-7
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H

Hand strap, attaching, 1-9
Handling batteries, 1-8 to 1-9
Help, EPSON, 4 to 5

I

Image Expert
albums, 5-4 to 5-5, 6-2 to 6-9
camera settings, changing, 8-5 to 8-6
Camio Viewer, 5-5 to 5-8
color correcting, 7-3 to 7-4
color depth, changing, 7-8
copying pictures to diskette, 6-8 to 6-9
correcting images, 7-3 to 7-4
cropping, 7-4
editing pictures, 7-1 to 7-8
e-mailing pictures, 6-11
error messages, 4-7 to 4-8
flipping images, 7-7
picture information, 6-3 to 6-4
printing, 6-4 to 6-6
Quick Fix, 7-2 to 7-3
Quick Tour, 4-5
resizing images, 7-5 to 7-6
resolution, changing, 7-5 to 7-6

rotating, 7-6
screen saver, 6-9 to 6-10
selection tools, 7-2
shutter speed, setting, 8-4
slide shows, 6-7 to 6-8
special effects, 7-7 to 7-8
taking pictures from computer, 8-1 to 8-3
transferring pictures, 4-4 to 4-8, 5-5 to 5-8
wallpaper, 6-10
zoom tool, 7-2

Images, see Pictures
Importing photos, TWAIN programs, 4-9 to 4-10
Information menu, 3-2
Installing

batteries, 1-6 to 1-7
software, 1-10 to 1-12

Internet, 4
Inverting images, 7-7 to 7-8

J

JPEG files, 4-10 to 4-11, 5-2

L

Language menu, 3-3
Language, setting, 1-12 to 1-13
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LCD screen
copying to and from memory card, 10-7 to 10-8
customizing settings, 8-8 to 8-11
displaying memory information, 10-6
erasing pictures, 3-6 to 3-8
formatting memory card, 10-4 to 10-5
locking and unlocking pictures, 3-9 to 3-11
menus, 3-2
problems, 11-3
setting alert beep, 8-10
setting brightness, 8-10
setting date and time, 8-9
setting multi-frame shooting time, 8-11

Live preview, 8-1 to 8-5
Locking and unlocking pictures, 3-9 to 3-11

M

Macintosh
capturing screens, 9-8
connecting to camera, 4-1 to 4-4
uploading pictures, 9-4 to 9-8

Maintenance, 11-1 to 11-2
Memory capacity, 10-2
Memory cards, see CompactFlash memory cards
Memory information, 10-6
Multi-frame mode, 2-12

N

Negative images, 7-7

O

Option Menu, 3-3

P

Panorama, 2-11
PCMCIA adapter, 10-1, 10-3 to 10-4
PCX files, 4-11
Photo Control menu, 3-3, 3-7 to 3-11, 10-5
Photo File Uploader, 9-1 to 9-9
Photographic specifications, B-3
PhotoPC 600 camera

AC adapter, using with, 2-3, A-2
auto shut-off, 2-2, 8-2, 8-6, 8-8
cleaning, 11-1 to 11-2
connecting to Macintosh, 4-1 to 4-4
connecting to PC, 4-1 to 4-3
date, setting, 1-13 to 1-14, 8-9 to 8-10
display panel, 2-3
features, 2 to 3, 1-2
language, setting, 1-12 to 1-13
maintaining, 11-1 to 11-2
picture counter, 2-12
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PhotoPC 600 camera (continued)
problems, 11-2
problems, solving, 11-2 to 11-9
settings, adjusting, 2-6 to 2-9, 8-5 to 8-11
specifications, B-1 to B-4
storing, 11-2
time, setting, 1-13 to 1-14, 8-9
timer, 2-7
tripod, attaching to, A-3
turning on and off, 2-2
unpacking, 1-1

PhotoPC 600 software
installing, 1-10 to 1-12

Photos, see Pictures
Physical dimensions, B-1
PICT files, 4-11
Picture counter, 2-12
Pictures

capturing from computer, 8-1 to 8-5
close-up, 2-6
color correcting, 7-3 to 7-4
color depth, changing, 7-8
converting, 5-2
copying to diskette, 6-8 to 6-9
correcting, 7-2 to 7-4
counter, 2-12

Pictures (continued)
cropping, 7-4
digital zoom, 2-10 to 2-11
downloading, 4-4 to 4-12, 5-5 to 5-8
editing, 7-1 to 7-8
e-mailing, 6-11
erasing, 3-6 to 3-8, 4-7, 4-10, 4-11, 5-6
exporting, 4-10 to 4-11
flipping, 7-7
information, 3-5 to 3-6
inserting in documents, 5-1 to 5-8
inverting, 7-7 to 7-8
locking and unlocking, 3-9 to 3-11
multi-frame, 2-10 to 2-12
organizing in albums, 6-2 to 6-3
panorama, 2-10 to 2-11
playing back on LCD screen, 3-1 to 3-11
playing back on TV, 3-12
printing, 6-4 to 6-6, 8-11
problems, solving, 11-7 to 11-9
resizing, 7-5 to 7-6
rotating, 7-6
screen saver, 6-9 to 6-10
selecting sections, 7-2
slide shows, 3-5, 6-7 to 6-8
special effects, 7-7 to 7-8
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Pictures (continued)
storage capacity of camera, 10-2, 10-6
transferring from camera, 4-4 to 4-12, 5-5 to 5-8
transferring from memory card, 10-3 to 10-4, 

10-7 to 10-8
uploading, 9-1 to 9-5
viewing information, 3-5 to 3-6, 6-3 to 6-4
wallpaper, 6-10

Playback Mode menu, 3-3
Playing back pictures, 3-1 to 3-12
Power

AC adapter, 2-3, A-1 to A-2, B-4
battery, see Batteries
camera specifications, B-1
problems, 11-2
saving, 2-2

Presentations, using camera for, 9-1 to 9-9
Printing pictures, 6-4 to 6-6, 8-11
Problems

camera, 11-2 to 11-6
picture, 11-7 to 11-9

Projector, playing back pictures and presentations, 9-9

Q

Quick Fix, 7-2 to 7-3

R

RAM, system requirements, 3 to 4
Registration, 5
Resizing files, 7-5 to 7-6
Resolution, changing, 7-5 to 7-6
Ripples effect, 7-7
Rotating pictures, 7-6

S

Safety instructions, 6 to 7
Safety specifications, B-1
Save to Floppy option, 6-8
Screen captures, 9-6 to 9-8
Serial cable, 4-2 to 4-3
Settings menu, 3-2, 8-8 to 8-11
Sharpness, adjusting, 7-3
Shut-off, automatic, 2-2, 8-2, 8-6, 8-8
Shutter, snapping, 2-3 to 2-4
Simple Technology, 10-5
Slide Show menu, 3-3
Slide shows, 3-5, 6-7 to 6-8
Snapping the shutter, 2-3 to 2-4
Software, installing, 1-10 to 1-12

see also Image Expert, EPSON Photo!2
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SoundAdvice, 4
Special effects, 7-7 to 7-8
Specifications, B-1 to B-4
Storing camera, 11-2
Strap, attaching, 1-9
Support

EPSON, 4 to 5
software, 5

System requirements, 3

T

Taking pictures, 2-1 to 2-12
close-up, 2-6
using the flash, 2-6 to 2-7
digital zoom, 2-10 to 2-11
multi-frame, 2-11 to 2-12
panorama, 2-11
with the LCD screen, 2-5
with the timer, 2-7
with the view finder, 2-3 to 2-4

Technical support, 4 to 5
Time, setting, 1-13 to 1-14, 8-9
Timer, 2-7
Tripod, A-3
Troubleshooting, 11-2 to 11-9

Turning camera on and off, 2-2
TWAIN programs, acquiring photos, 4-9 to 4-10

U

Unlocking pictures, 3-10 to 3-11
Unpacking the camera, 1-1
Uploading

pictures, 9-1 to 9-5
programs, 8-11

V

VCR, playing back pictures, 3-12
Video cable, 3-12, 9-9
Videotaping pictures, 3-12

W

Windows
capturing screens, 9-6 to 9-7
uploading pictures, 9-2 to 9-4

World Wide Web, 4

Z

Zoom, 2-10 to 2-11
Zoom tool, 7-2
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